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1 Introduction 

BrainyBEE is a comprehensive fully autonomous flight avionics and ground control system developed by 

Aerojeep. It provides a scalable solution for a UAV network of various types including fixed wing aircraft, 

helicopter, airship and VTOL. BrainyBEE is network enabled for remote monitor and control by secondary 

ground stations or by third party applications such as an optimal trajectory generation tool. 

 

A complete BrainyBEE flight control system includes a BrainyBEE ground station, one or many BrainyBEE 

avionics controllers with proper wireless data links, and optionally a number of remote ground stations and live 

video links. 

1.1 BrainyBEE Avionics Controller 

The BrainyBEE avionics controller fits great features in an exceptionally small size: 

 Weight: 20 grams(0.7oz); Size: 6.5cm x 4.2cm (2.5inch x 1.6inch) 

 Powerful Digital Signal Processor, 150MHz/150 MIPS, 128K Words internal flash memory, 18K Words 

SRAM, 16 12-bit ADC channels, two SCI ports, one SPI port, one CAN port;  

 Full set of IMU sensors including 3 MEMS gyros, three-axis accelerometer, and 3-axis magnetometer; 

Altimeter sensor with 15 centimeter resolution provides an aid to the GPS vertical positioning. 

 An integrated 72/50/40 MHz FSK(Frequency Shift Key) receiver plus an external receiver of customer 

choice provide manual flight and payload control via common hobby RC transmitter. 

 Manual control is also available through joystick game controller with extended range via wireless data 

link. 

 Plenty of ADC and communications ports to support external modules including GPS and wireless data 

modem, and external sensors such as sonar and laser ring gyros. 

 8 flight control servo outputs. 

 6 payload servo outputs for custom applications such as parachute, camera, etc. 

 Numerous digital I/O for customized features. 

 Standalone avionics can provide real-time attitude control with extended Kalman filter running in 

attitude-only mode. 

 With add-on GPS module, avionics software with extended Kalman filter enables fully autonomous flight 

control, for fixed-wing aircraft, helicopter, airship and VTOL UAVs. 

 Add-on wireless data modem allows up to 40 mile (64 kilometers) operational range with full command, 

control and communications capability. 

 Advanced nonlinear feedback neural network adaptive flight control ensures robust self-learning and 

trajectory tracking performance. 

 Feature-rich integrated support for roll-pan-tilt tri-axis (or any double or single axis) stabilized camera 

gimbals, capable of keeping camera line-of-sight to a fixed direction or locking onto a target. 

 Comprehensive support for aerial survey, easy generation of area scan trajectories, autonomous payload 
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trigger at preset intervals, and logging of trigger events to facilitate post flight data processing such as 

image stitching. 

1.2 Data Link 

In addition to direct manual control via onboard receivers, two-way communications between the BrainyBEE 

avionics controller and the ground station can be established with wireless serial data modems. BrainyBEE 

system is equipped with Maxstream’s XTend wireless modules with ranges up to 64km(40miles) at 9600baud 

under outdoor line-of-sight condition. At the high data rate of 115200 baud, the maximum range is 32km(20miles) 

with high gain antenna, or 11km(7miles) with small dipole antenna. Maxstream’s XTend modems are chosen for 

its exceptional performance and small size. The onboard module weighs at only 18 grams(0.64oz.), yet has 

unrivalled long range and 256-bit AES encryption for high security applications. 

 

Users can choose to substitute with any other serial data modems, or even a satellite link for extended range. 

1.3 BrainyBEE Ground Station 

Aerojeep's BrainyBEE ground station software provides a user friendly GUI with comprehensive integrated 

command and control capabilities. Key features include: 

 

(a) A moving map that lets operator move around, zoom in and out of any area of interest, define flight plans, 

mission targets and threats with intuitive mouse clicks. The operator can edit waypoints in real time, or simply 

drag and drop any waypoint with the mouse pointer. Manual control is available through either a radio 

transmitter, or a joystick game controller connected to the ground station, or with the slider widgets just under 

the moving map. 

 

(b) Vehicle configuration window defines properties for individual avionics controller under the familiar 

navigation, guidance and control paradigm. All parameters can be tuned in real time while in flight. Data 

structure, display as well as guidance and control algorithms are meticulously designed and reflect various 

vehicle types including fixed wing, helicopter, airship and VTOL. 

 

(c) Portability and scalability are among top design considerations from get-go. The BrainyBEE ground station 

software is built upon OpenGL and other portable libraries for easy migration to diverse platforms such as Linux 

or handheld computers. The command and data structures are designed to scale well for any number of 

networked UAVs. 

 

(d) The BrainyBEE ground station software constitutes a complete software-in-the-loop simulation testbed as 

well as a real-time visualization tool. New avionics configurations can be tried out with software-in-the-loop test 

by connecting to a third party flight simulator, such as FlightGear or X-plane. During real-time flight control, 

FlightGear or X-plane can be deployed alongside the ground station as a 3D visualization aid for the pilot, and 
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the 3D scenery can be compared with real-time video to enhance situational awareness. 

 

(e) The BrainyBEE avionics system is designed to provide support for coordinated flight control of networked 

UAVs. Vehicle properties and flight constraints, along with target and threat data sets are made available for 

third-party optimal trajectory generation tool, which would produce flight plans that maximize overall target 

coverage while minimizing exposure to threats. The trajectory generation software can run at the ground station 

with optimal flight plans transmitted to each vehicle in real time. Alternatively, to achieve the highest level of 

automation and robust performance, each vehicle can run trajectory generation software onboard, with the 

knowledge of the nearby targets, threats and neighboring vehicles.  

 

(f) The BrainyBEE ground station can be run in four modes: software simulation, real-time flight control, 

playback and remote terminal. All flight data are recorded into log files, and can be replayed in the playback 

mode, at normal speed, fast forward or frame by frame to enable comprehensive post-flight analysis. A number 

of remote ground stations can connect to the main ground station via the Internet. The remote ground station 

feature allows the monitor and control of the UAV network by several operators, or by paying customers, or by 

an expert tuning avionics configurations remotely. 

 

(g) BrainyBEELiveVideo software connects to the ground station to display live videos from video downlink, 

with optional HUD (Heads-Up Display) feature to superimpose telemetry data onto the live video display; A 

right mouse click would capture and display real-time image for close-up analysis; Efficient real-time MPEG2 

compression filter saves live video onto hard drive without slowing down the primary ground station software. 

 

(h) BrainyBEE flight control system is designed for users around the world; The BrainyBEE Ground Station has 

been “internationalized” with GNU Gettext framework for native language support, so that end users can operate 

a UAV network in a human language they are most comfortable with. 
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2 Quick Demo 

The BrainyBEE ground station is a comprehensive command and control center for a network of different UAV 

types. It is also a seamlessly integrated workbench for training, software simulation, vehicle tuning, real-time 3D 

visualization and post flight analysis. 

 

The best way to get acquainted with the BrainyBEE flight control system is to sit back and take a test drive. The 

BrainyBEE operator interface can demonstrate its myriad of features in Software Simulation, Playback and 

Remote Terminal modes. (Only the Flight Control Mode requires the presence of a BrainyBEE avionics 

controller and wireless data modems.) 

 

The BrainyBEE installation package includes a sample UAV network. A user can experience first-hand the look 

and feel as well as the numerous advanced features and functionalities of the BrainyBEE flight control system. 

For a truly realistic experience, a third-party flight simulator, either FlightGear or X-Plane, should also be 

installed and connected to the BrainyBEE operator interface. 

 

First, check the hardware requirements as shown in Section 4.1 “Ground Station Reference Configuration”; then 

follow the easy instructions in Section 4.2 “Software Installation” to install the BrainyBEE operator interface, 

and optionally the FlightGear and X-Plane flight simulators on your computer. Must follow the instructions to set 

up X-Plane properly. (The BrainyBEE operator interface and flight simulator are both graphic intensive 

applications. Thus it’s best to run the flight simulator on a separate machine. If they both have to run on the 

same machine, make sure the host computer has a high performance graphic board and lots of RAM. Sometimes 

the processing delay can cause the aircraft to oscillate or even crash in the flight simulator. To alleviate the 

situation, turn off some features on the operator interface such as gridlines, vehicle tracks, trajectories, 

landmarks etc. Or minimize the moving map all together and open the avionics window only.) 

 

An example UAV network is provided with the BrainyBEE installation package. Go to the BrainyBEE root 

directory that you have chosen during installation, then go to data\VehicleNetwork, copy all sample avionics 

configuration files in the Example\ sub-folder to the data\VehicleNetwork folder.  

 

Now make sure you’re sitting tight and ready for launch. 

 

Step A) Start the BrainyBEE operator interface by selecting “Start->All Programs->Aerojeep 

->BrainyBEEGroundStation”. When the “Select Operation Mode” window opens, choose “Software 

Simulation” then click ok to launch the BrainyBEE operator interface. Take a look around the moving map. 

Notice that there is a “Select Focus Vehicle” window in the bottom left corner. Double click the entry with 

vehicle id “22220” and confirm to select this vehicle as the focus vehicle, since its flight trajectories and 

control parameters have been set for a “live” demo with the FlightGear simulator (Vehicle 22222 is a fixed 

wing model plane set to work with X-Plane). Now the avionics window should be open for the focus 
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vehicle. Make sure the vehicle is stopped and not tracking by pressing the “Stop Tracking” button under the 

Guidance tab if necessary. The “Stop Tracking” button will read “Enable Tracking” if the vehicle is 

currently not in the tracking mode. 

 

Step B) Launch the FlightGear or X-Plane flight simulator. In the case of FlightGear, Aerojeep has modified its 

network interface to suit our needs and to improve efficiency; Launch the modified version by selecting 

from Start menu “Aerojeep->FlightGear_SWI_Simulation.bat”. For X-Plane, start in normal ways, then 

select the model fixed-wing aircraft with “File->Open Aircraft->Radio Control->PT_60”. Select the Chino 

airport with “Location->Place Aircraft by Airport->Chino”. X-Plane can simulate various kinds of system 

failures. Make sure all system failures, particularly engine failure are turned off from the “Settings->System 

Failures…” window. 

 

Step C) On the left panel, there is a Flight Simulator selector. Choose FlightGear or X-Plane, a small 

connection window opens. Confirm or change IP address (which is 127.0.0.1 if the flight simulator is run on 

the same computer), then click Connect button. If the connection succeeds, the focus vehicle will be 

updated with navigation data from the flight simulator. (All other vehicles are not affected and their 

navigation data continue to be updated based on guidance information.) The BrainyBEE flight control loop 

now produces proper throttle and control surface actuations to send to the flight simulator. (A white “flight 

track” might appear from where the aircraft was to its current location. Flight tracks can be cleared by 

clicking the “Clear” button after “Vehicle Track” in the right panel of the operator interface.) 

 

Step D) The focus vehicle with id “22220” (or 22222) should now stop at one end of a runway. If you can not 

see the red focus vehicle symbol in the moving map, check the “Center Focus Vehicle” box in the right 

panel of the operator interface, which would place the focus vehicle in the center of the moving map. Check 

the “Public Landmark” box and make sure “Airport” box is also checked. To zoom in or out, press down the 

amplifier box just over the “Center Focus Vehicle” line. Now move the mouse cursor inside the moving map. 

Each left mouse click would zoom in by 50%, while every right mouse click would zoom out by 50%. Keep 

trying until you can see the runway and the flight trajectory over the runway roughly fill the moving map. 

Now press the pointer button to the left of the amplifier button to place the moving map back in edit mode. 

Uncheck “Center Focus Vehicle”. 

 

Step E) Now the flight simulation can start in manual or autopilot mode (exactly the same as in real-time Flight 

Control Mode). If the aircraft had moved from the end of runway for takeoff, its position should be reset: 

For FlightGear, from the top menu bar, select “Location->Position Aircraft(on ground)”; For X-Plane, from 

the top menu bar, select “Location->Takeoff->Chino”. 

 

Step F) A flight trajectory has been defined for vehicle 22220 (or 22222) for fully autonomous flight including 

takeoff and landing at the same airport. Highlight the “Takeoff” waypoint over the runway with an arrow 

pointing up with a left mouse click, then click the right mouse to open a popup choice menu, select “Set 

Waypoint Active”. This “Takeoff” waypoint turns green and the whole trajectory it belongs to turns bright 

red to indicate it is the active trajectory. Now click the Guidance tab of the focus avionics window, press 
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“Enable Tracking” to start fully autonomous flight. The aircraft should start accelerating and soon becomes 

airborne. 

 

Step G) When the airplane flies past the “Takeoff” waypoint, it returns to red as the next waypoint turns green. 

The airplane will make a turn to follow the planned trajectory toward the next waypoint. Double clicking a 

waypoint symbol would open a waypoint edit window, with properties mostly self-explanatory. Make 

changes to these properties and see what happens. The waypoints can simply be dragged and dropped with 

the left mouse as well. 

 

 

Figure 2-1 Software Simulation with FlightGear Flight Simulator 

Step H) Pressing the “v” key while the FlightGear has the cursor focus will switch between several different 

viewing angles. For X-Plane, many view short cuts can be found under the “View” top menu. Both flight 

simulators can also emulate different weather conditions. Read their manuals to find out more. 

 

Step I) You can design flight trajectories for other vehicles. Each vehicle can run in fully autonomous mode by 

pressing “Enable Tracking” under the guidance tab after you have selected an active waypoint. Only the 

focus vehicle is connected with the flight simulator. Other vehicles’ navigation data are updated as 

realistically as possible based on the properties defined by their respective active waypoints. A UAV 

network should now be seen flying all over the map. 

 

Step J) FlightGear can only simulate fixed-wing aircraft. The vehicle “33333 raptor30” has been defined so 
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users can experience autonomous flight of a model helicopter with X-Plane. Simply double click the vehicle 

“33333” in the “Select Focus Vehicle” window to set it as the focus vehicle. Follow the Steps B-I again, but 

this time choose X-Plane as the flight simulator, and select the Raptor 30 model helicopter from the X-Plane 

top menu bar “File->Open Aircraft->Radio Control->Raptor30”. 

 

 

Figure 2-2 Software Simulation with X-Plane Flight Simulator 

 

Step K) You can open a remote ground station that connects to this host ground station. See details in Section 

4.3.1.4 “ Remote Terminal Mode”. 

 

Step L) When you are done with the Software Simulation mode, exit by clicking the cross on the top right 

corner of the operator interface, or select “File->Quit”. The BrainyBEE ground station saves all 

configurations files, closes the log file for this session, then exit. 

 

Step M) Restart the BrainyBEE operator interface, this time in the Playback Mode. Follow the easy instructions 

in Section 4.3.1.3 Playback Mode to replay the flight in normal speed, ten times fast forward, or frame by 

frame. 

 

Step N) BrainyBEELiveVideo software is provided for preview and capture of live video via a video capture 

device based on the Windows Driver Model (WDM) or the older Video for Windows (VfW) standard. The 

video capture device must be plugged in before starting BrainyBEELiveVideo. Select “File->Set HUD 
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Display…” to activate Heads-Up Display (HUD) feature and select the vehicle ID whose telemetry data 

shall be superimposed onto the live video. The ground station must have network interface turned on for the 

BrainyBEELiveVideo software to connect, which can run on the same host computer or separate computers. 

Unlimited copies of BrainyBEELiveVideo software can run on the same host computer to display live 

videos from multiple video cameras, simply select the respective video capture device from the Devices 

menu. Select “File->Set Capture File…”, then “Capture->Start Capture” to save live video to a file in 

compressed MPEG2 format. Move the mouse cursor over the live video and click the right mouse to capture 

the real-time image which is opened and shown by the default graphics display software. 
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3 BrainyBEE Avionics Controller 

The BrainyBEE avionics controller is the world’s first micro flight controller that is designed to support a UAV 

network of various types including fixed wing aircraft, airship, helicopter and VTOL UAVs. Its brain power 

derives from a very capable Digital Signal Processor, which packs a high-performance 150MHz/150MIPS 32-bit 

CPU with 128K Words internal flash memory, 18K Words SRAM, and peripherals including 16 channel 12-bit 

ADC, 2 SCI ports, 1 SPI port, and 1 CAN port. The impressive power of the DSP allows the BrainyBEE avionics 

controller to distinguish itself as the world’s first single-chip solution with a highly optimized extended Kalman 

filter for full-state navigation and control of practically anything that can fly. 

 

 

Figure 3-1 BrainyBEE Avionics Controller Functional Diagram 

 

Figure 3-1 is the functional diagram of the BrainyBEE avionics controller. The extended Kalman filter 

seamlessly integrates multiple sensor inputs from gyros, accelerometers, magnetometers, altimeter and GPS to 
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provide high-bandwidth real-time attitude for navigation and control. Flight plans can be defined and uploaded to 

the BrainyBEE avionics controller in real-time for fully autonomous flight. See detailed descriptions in related 

sections in Chapter 4 BrainyBEE Ground Station. 

 

The upper-right functional block labeled “Optimal Trajectory Generation” is an advanced feature that is to be 

implemented in future release or provided by third party software. The goal is to allow users to focus on high 

level mission objectives such as defining targets and threats, and leave it to the optimal trajectory generation tool 

to produce trajectories in real-time for a UAV network that maximize the coverage of the targets while avoiding 

threats and meeting other mission constraints. See detailed discussions in Chapter 4 BrainyBEE Ground Station. 

3.1 Configuring Wireless Data Modem 

While the BrainyBEE avionics controller can operate standalone in manual or velocity control mode, fully 

autonomous interactive flight control requires wireless serial data modems for two-way communication between 

the BrainyBEE avionics controller and the BrainyBEE ground station. 

 

Users can choose virtually any serial data modems to suit their range and performance requirements. BrainyBEE 

flight control system by default is equipped with Maxstream’s XTend wireless data modem, chosen for its 

exceptionally small size and high performance, with line-of-sight range up to 64 km (40 miles) with high-gain 

antenna. Please refer to XTend’s data sheet and user manuals for more details on its capability and operation. 

 

No matter which wireless data modems are chosen, there are 

two data interfaces that must be properly configured. The first 

is the serial interface between the data modem and the user 

application (which is the avionics controller or ground station in 

our case), and must be set as the following: Baud rate 115200, 

no flow control, 8 data bits, no parity, 1 stop bit. The second is 

the RF interface which defines the over-the-air communications 

between two modems. Higher RF data rate means higher data 

throughput and better performance, but at the expense of 

shorter range. XTend has two RF data rates that can be chosen: 

9600 and 115200. The higher data rate is strongly 

recommended, particularly if multiple UAVs are under control. 

 

Maxstream provides a configuration and diagnosis software 

called X-CTU. Aerojeep has defined a modem configuration 

profile that is preloaded into XTend modems before shipping to 

users. A development kit from Maxstream with a base module is necessary if a user needs to re-configure the 

modem. Plug the modem onto the base module, run X-CTU, under “Modem Configuration” tab, press 

Profile->Load button, then choose Aerojeep/BrainyBEEGroundStation/Maxstream/brainybee.pro. The 

 

Figure 3-2 Maxstream XTend Data Modem 
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configuration must be loaded into the XTend modem by pressing “Modem Parameters and Firmware->Write” 

button. It should be noted that DIP switches 1, 5 and 6 in the back of the ground station RS232 modem must be 

in the up position, while switches 2, 3, and 4 stay down for our custom defined configuration to take effect after 

power up. 

3.2 Configuring Ublox GPS 

The BrainyBEE avionics controller has a full set of INS sensors including gyros, accelerometers and 

magnetometers. Without a GPS module, the extended Kalman filter would work in the attitude-only mode. 

However, in the absence of position and velocity feedback, trajectory tracking is not possible.  

 

A GPS unit with good dynamic performance would enable the 

Kalman filter to track attitude as well as position and velocity 

accurately. The SAM-LS smart antenna module from U-blox AG 

combines an ultra-low power GPS receiver with an integrated patch 

antenna. Stamp-sized and weighing at only 23 grams, U-blox 

SAM-LS packs impressive features: 16 channels, 8192 

simultaneous time-frequency search bins, and most significant for 

avionics applications, it can update position and velocity 4 times a 

second. 

 

High position update rate translates into good dynamic performance 

for avionics. SAM-LS supports the text-based NMEA protocol, 

which is the de-facto international standard for GPS. However, for higher data throughput required for 4-Hz 

update rate, U-blox defined a proprietary binary protocol called UBX. BrainyBEE avionics by default supports 

UBX protocol only, and has a tiny 20-pin, 0.5mm pitch FFC (Flat Flex Cable) connector designed specifically to 

connect with SAM-LS. However, standard size serial port I/O pins are also available in case users need to use 

their own GPS unit, which would require some software customization as well. 

 

U-blox AG provides a configuration and diagnosis software tool called u-center. Aerojeep has defined a SAM-LS 

configuration that enables binary UBX protocol with the following messages turned on: NAV-POSLLH, 

NAV-DOP, NAV-STATUS, NAV-VELNED, NAV_SVINFO and RXM_RAW. An adapter board and TTL-RS232 

serial converter is required if a user needs to re-configure the SAM-LS. Run u-center, open Tools->GPS 

Configuration, then load Aerojeep/BrainyBEEGroundStation/ublox/ublox_brainybee.txt. The configuration then 

must be loaded into the SAM-LS GPS unit. 

 

Figure 3-3 U-blox SAM-LS GPS Unit 
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3.3 Installing BrainyBEE Avionics Controller 

 

Figure 3-4 BrainyBEE avionics controller layout 

Figure 3-4 depicts the component side of the BrainyBEE avionics controller, which should be mounted close to 

the center of gravity and placed flat with the component side facing up and the arrow on top of Figure 3-4 

pointing to the nose. The IMU sensors are located on the lower left side of the board. They are sensitive to noise, 

heat and ferromagnetic metals such as iron and steel. Use a small magnet to look for ferromagnetic metals close 

to the autopilot. There must be sufficient distance between the magnetic sensors and onboard magnets or 

ferromagnetic metals. For example, the magnetic sensors should be at least 20 cm away from a 380 size electric 

motor; Keep distance with servos and if necessary replace screws, bolts, push rods and helicopter flybar beams 

with non-ferromagnetic material such as stainless steel or carbon composite parts. And it is critically important to 

keep any power and ground wires tied up in pairs so their generated magnetic fields would cancel out. The 

powerful DSP consumes about 1 Watt and could be rather hot to touch. Care must be taken to allow sufficient 

cool airflow and to keep mechanical vibration, heat source, electrical wires, ferromagnetic metals etc. away from 

the avionics board as much as practically possible. Noise and vibration can be a big problem for gas engines, 

particularly for helicopters whose rotor frequency is quite low and handicap the available control bandwidth. 

Front 



 

BrainyBEE Autonomous Flight System User Manual  
 

Copyright © 2007 Aerojeep Company 

16

Appropriate mechanical damping methods might be required with cutoff frequency carefully chosen as not to 

adversely impact control performance. 

 

There are two LEDs located near the lower center on the component side. At power up, the red LED will blink 

for a few seconds while the sensor readings are validated. The vehicle must be kept stationary for at least one 

second for the autopilot to properly start, after which the red LED stays solid on. The green LED shows the GPS 

status: it’s off when there is no GPS lock; dim green when GPS is in 2D fix or there is inconsistency in the 

accelerometer and magnetometer readings (See more details in Section 4.3.6.1 Navigation Tab); it’s bright green 

only when GPS has reached full 3D fix mode and the IMU sensor readings passed consistency check. The 

Kalman filter would only run in attitude mode if the GPS status is lower than 3D fix. Hence trajectory tracking 

would not be enabled without GPS 3D fix. 

 

The U-blox GPS receiver must be connected to SCI port A. A custom made wire is supplied to connect the 

Maxstream data modem to the SCI port B. Make sure the GPS has a clear view of the sky. GPS works with very 

weak signals, and extreme care must be taken to shield it from EMI interferences. Place GPS away from EMI 

sources such as engines, motors and servo wires. There should be at least a distance of 10cm between the GPS 

module and the BrainyBEE autopilot. The Maxtream wireless data modem must also be separated as far away 

from the GPS antenna as possible. If the magnetic sensor readings move around in a range of more than 1000nT 

while the aircraft is kept stationay on the ground, then the source of the interference should be identified and 

isolated. 

 

A light-weight high quality receiver is modified and connects via a servo wire to the port in the top left corner to 

serve as an integrated receiver, with all RC control channels processed through this port. 

 

Eight flight control servo outputs are aligned along the top edge. Their usage is dependant on flight 

configurations, and details are explained in Section 4.3.6.4 Actuation Tab. The top row is the ground, middle row 

is 5V servo power, and the bottom row is for servo signals. Six payload servo outputs line up to the right side of 

the flight servo ports, while six external receiver inputs populate the bottom right side. Both have the outside 

pins as ground, and the middle ones are 5V power. Any receiver can be used as the external receiver, simply 

connecting each control channels to the respective external receiver input ports, numbered channel 1 to 6 

counting from top to bottom. 

 

A 4-cell NiCd or NiMh battery can provide 5V power for the flight servos through any unused flight servo power 

and ground pins. NEVER USE more than 4 NiCd or NiMh cells to supply the 5V servo power, or permanent 

damage could result. If more battery cells are deployed, a 5V power regulator should be used which must be 

capable of powering all the flight servos. A separate 5V power source should be provided for the payload servos 

in similar fashion. The autopilot is equipped with a switching power regulation circuit which must be supplied by 

a power source with voltage range of 7-16 volts through the autopilot power port located in the top right corner. 
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3.4 Post Installation Configuration and Preflight Check 

The BrainyBEE autopilot is shipped with default settings. It must be configured and tested to work well after 

being installed in an aircraft. The BrainyBEE autopilot is configured through the Avionics Window of the 

BrainyBEE ground station operator interface. The BrainyBEE installation package provides sample vehicle 

configurations for some common models. More sample vehicle configurations will become available when more 

models are tested. 

 

Start with a sample vehicle configuration that is closest to your aircraft. Read the descriptions of each tabs under 

the Avionics Window in Section 4.3.6 Avionics Window. Modify the settings as necessary.  

 

If possible, search for an aircraft model that is closest to your model among the many available for the 

FlightGear or X-Plane flight simulator. Much more models are available for download from their websites. You 

might need to modify the aircraft parameters or even design a new aircraft for the flight simulator to mimic the 

behavior of your aircraft. Find out more about each flight simulator at their respective websites. Then tune and 

“test fly” your model in the software simulation mode with one of the flight simulators. 

 

With or without flight simulation, the vehicle configurations can only be fine tuned with actual flight tests. 

Remember to save and back up your vehicle configuration files along the way so you can restore to what worked 

before. 

 

Before each flight, carefully design and review your flight plans, and go through all the tabs of the vehicle 

window to verify that they are what they are supposed to be. And follow these tips for safe and reliable flights: 

 Look out for loose parts and unbalanced props which could induce excessive vibration that may lead to 

sensor failure. 

 Use a small magnet to uncover any ferromagnetic objects that are inadvertently placed close to the 

BrainyBEE autopilot, as even a small ferromagnetic screw could severely distort the measurement of 

Earth’s magnetic field. 

 Make sure the receiver is set up such that channel 5 defaults to autopilot mode when the transmitter is 

turned off. 

 After power on keep the vehicle stationary for at least 1 second so that the BrainyBEE autopilot can 

perform sensor reading validation and properly initialize. 

 Before vehicle takeoff, flip channel 5 back and forth at least three times to reset the servos to their neutral 

positions. But remember never to reset servos during the flight. 
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3.5 I/O Expansion 

Expansion I/O pins on the bottom right side are reserved for future enhancement or custom applications. They 

include ADC pins to take analog inputs, one SPI port, one McBSP port (Multichannel Buffered Serial Port), one 

eCAN port (Enhanced Controller Area Network) and many general-purpose I/O pins. 
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4 BrainyBEE Ground Station 

The BrainyBEE ground station is more than a user friendly command and control center for a UAV network of 

different vehicle types. It is also a seamlessly integrated workbench for training, software simulation, vehicle 

tuning, real-time 3D visualization and post flight analysis. 

4.1 Ground Station Reference Configuration 

The BrainyBEE ground station usually consists of two components: a notebook computer running the 

BrainyBEE operator interface, and a serial wireless data modem. As noted earlier, Maxstream’s XTend modems 

are chosen by Aerojeep for their exceptional performance and compact size, though users can freely choose their 

own serial data modem and antenna to suit their range and performance requirements. Connect a battery if 

necessary to provide power to the XTend modem. Then connect the XTend modem to the notebook computer’s 

serial port. Since serial port is being gradually phased out and replaced by USB ports on many notebook 

computers, a USB-serial port adapter might be required. 

 

The BrainyBEE ground station software runs many demanding tasks simultaneously including real-time data and 

command processing and GUI(Graphical User Interface) updates. A powerful yet power-saving notebook is 

required for good performance and reasonable endurance. Gratefully nowadays a “loaded” notebook can be 

acquired at very reasonable cost. The following reference configuration could cost only slightly over $1000 in 

mid 2006: 

 

 Intel Pentium M Dual Core processor; Pentium M is highly recommended for its power-saving features; 

Dual Core significantly improves performance when the BrainyBEE ground station and a flight simulator is 

run side by side on the same computer. 

 Windows XP or Vista 

 1 GB of RAM 

 Standalone high performance graphics card with at least 64MB RAM (A fast graphics board that supports 

OpenGL is absolutely critical to overall performance, particularly when a flight simulator is also run on the 

same computer) 

 Wide screen with bright screen feature to improve outdoor visibility 

 At least 3 USB ports: one for mouse, one for joystick game controller, one for data modem 

 Wireless network connection if necessary to allow real-time monitor and control by one or several remote 

ground stations via the Internet 
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4.2 Software Installation and Native Language Support 

Inserting the BrainyBEE setup CDROM, double click setup.exe and follow the onscreen instructions to install 

the BrainyBEE ground station software on your ground station computer. A root directory 

Aerojeep\BrainyBEEGroundStation is created for this application under C:\Program Files, unless a different 

location was chosen during installation. Meanwhile, a folder called Aerojeep is added to the Start program menu 

which includes the BrainyBEEGroundStation and BrainyBEELiveVideo software, utility programs including 

AtlasMapMaker and FlightGear simulator batch files, and this user manual.  

 

Next go to the Aerojeep root directory, double click the instFilter.vbs file to install video processing filters for the 

BrainyBEELiveVideo software. 

 

BrainyBEE flight control system is designed for the convenience of users around the world. The BrainyBEE 

Ground Station has been “internationalized” with GNU Gettext framework for native language support, so that 

end users can operate a UAV network in a human language they are most comfortable with. A single text file 

with all text strings in English used by the BrainyBEE ground station needs to be translated into any local 

language. After formatting with a GNU Gettext utility program, the users in that part of the region can operate 

the UAV network in their native language simply by setting the proper regional option: Open “Control 

Panel->Date,Time,Language,and Regional Options->Regional and Language Options->Regional Options”, 

under the “Standards and formats” group, select the proper regional language. It should be noted that most likely 

the proper regional option has already been configured as default by computer manufacturers for their customers 

based on their regions. 

 

The FlightGear and/or X-plane flight simulators are highly recommended to be installed as well. See details in 

Section 4.5 Flight Simulation and Real-time 3D Visualization. 

 

All BrainyBEE files are installed under the BrainyBEE root directory. They include program executables for the 

ground station and utility programs, plus the user manual. The folders Maxstream\ and Ublox\ respectively 

contain the data sheet, manuals as well as configuration files for the Maxstream XTend modems and Ublox GPS 

module. 

 

The folder data\ under the root directory has configuration subfolders for the operation of the BrainyBEE 

command and control system. The subfolders include: 

 GroundStation\ - Configuration files for the BrainyBEE operator interface. 

 Maps\ – Stores map files for three types of moving maps: AtlasTopo, StreetMap and AerialPhoto. 

 PublicLandmarks\ - Stores public info such as airports, and other navigation aids. 

 VehicleNetwork\ - Each vehicle stores its own configuration files here. 

 Log\ - Each run session (except for playback mode) stores all real-time command and data in a 

time-stamped log file for post-flight analysis. 

 CommandFile\ - Advanced feature that executes all commands in a binary file named commands.cmd right 
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away then deleting it. 

 Fonts\ - Used by BrainyBEE ground station to display text in graphic mode; do not make any changes. 

 

BrainyBEE configuration files are all text-based, and can be read and modified with any plain text editor. But 

except for a few cases noted in related sections, it is strongly discouraged to modify these files by hand, because 

an accidental error could cause system instability. It is the user’s responsibility to backup configuration files and 

folders as they see fit in case they need to restore the configurations to a previously working state. 

 

Mode details on these folders are revealed in related sections below. 

4.3 Ground Station Operator Interface 

The BrainyBEE ground station has a state-of-the-art modular architecture with a user friendly GUI operator 

interface. All commands and data are accessible with mouse clicks, drag and drop. The intuitive GUI design 

flattens the learning curve, and enables the operator to focus on the mission rather than the operation of the flight 

control system. 

 

Anytime a user is not sure about an item on the operator interface, move the mouser cursor over the item and 

stay for a few seconds, a popup message would briefly explain. 

4.3.1 Ground Station Operation Modes 

When the BrainyBEE ground station operator interface is started, a 

small window titled “Select Operation Mode” opens. Select one of 

four operation modes: Software Simulation, Flight Control, 

Playback or Remote Terminal, then click OK to start the ground 

station operator interface in the selected operation mode 

distinguished by four different background colors. The title of the 

operator interface window would also indicate the current mode of 

operation. 

 

Figure 4-1 Select Operation Mode 
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4.3.1.1  Software Simulation Mode 

 

Figure 4-2 Operator Interface in Software Simulation Mode 

The BrainyBEE ground station is more than a command and control interface. It provides a convenient and 

risk-free training and simulation platform in software simulation mode. Users would have the opportunity to get 

familiarized with the look and feel of the ground station operator interface, try out all commands and see the 

results simulated as realistically as possible. 

 

One of two popular flight simulators, FlightGear and X-Plane, can connect to the ground station in software 

simulation mode to provide realistic “software in the loop” simulation. Both FlightGear and X-Plane have 

impressive 3D scenery and let users choose various flying models. Flight simulators not only greatly enhance the 

training experience, more significantly they can quite accurately represent the behaviors of the vehicle so users 

can tune control and guidance parameters before actual flight, thus saving time and reducing the risk of accident. 

See the related section below for more details on flight simulations. 
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If several vehicles are defined in the UAV network, only one “focus” vehicle will receive user commands 

through the operator interface. If a flight simulator is connected, the navigation data of the focus vehicle gets 

updated by the flight simulator, while the BrainyBEE guidance and control loop sends control signals to the 

flight simulator. For all other vehicles (including the focus vehicle without a flight simulator), the navigation data 

are updated as realistically as possible based on the guidance data for the currently active waypoint. 
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4.3.1.2  Flight Control Mode 

 

Figure 4-3 Operator Interface in Flight Control Mode 

When in Flight Control Mode, the BrainyBEE ground station can monitor and control via the wireless data 

modem a UAV network of various vehicle types including fixed wing aircraft, helicopter and VTOL. At any time 

only one focus vehicle gets the user commands through the operator interface, while the other vehicles must be 

in the autopilot mode. It should be noted that other vehicles can still receive user commands from sources other 

than the local operator interface, such as a RC transmitter, a command file, or user commands from the remote 

ground station that has chosen a different focus vehicle, or a third party optimal trajectory generation software. 

Each vehicle is identified with a unique 16-bit ID. 

 

A flight simulator, either FlightGear or X-Plane, can connect to the BrainyBEE ground station in real flight mode 

for realistic 3D visualization and improved situational awareness, since the 3D sceneries are produced with real 

world data. See more details in the section on Flight Simulation. 
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4.3.1.3  Playback Mode 

 

Figure 4-4 Operator Interface in Playback Mode 

The BrainyBEE ground station saves all commands and data in a time stamped log file for each session in the 

data\log folder (except for the Playback mode, of course). A user can relocate the log files under their own 

sub-folders for classification purpose. In the Playback mode, there is a log file selector in the left panel that lists 

all log files and sub-folders in the data\log folder. Click on a sub-folder to display contents in that folder. Click 

on a log file to be replayed, then press the play button to replay in normal speed. Clicking the double arrow 

button would replay at ten times the normal speed. Frame by frame (0.25 second interval) replay is also available 

by clicking the button to the left of the play button. The very first button from the left would reset the log file to 

the start. The slider above the play buttons shows the progress of replay in seconds. Dragging the slider would 

reset the point of replay to anywhere in the log file. Since all commands and data in the log files are executed or 

updated sequentially, dragging the slider would miss or repeat some commands. Hence it is wise not to skip at 

least the first few seconds of replay when the ground station and vehicle network configurations are loaded. 
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As in the Flight Control Mode, FlightGear or X-Plane flight simulator can connect to the BrainyBEE ground 

station for realistic 3D visualization and enhanced situational awareness. 
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4.3.1.4  Remote Terminal Mode 

 

Figure 4-5 Operator Interface in the Remote Terminal Mode 

The Remote Terminal Mode would allow the monitor and control of the vehicle network by any number of 

remote ground stations located anywhere in the world that connects to the primary ground station via the Internet 

(The primary ground station itself can be running in the Software Simulation, Flight Control or even Playback 

mode). The remote terminal feature opens many possibilities, such as allowing several operators for the UAV 

network; enabling the real-time monitor and control of the vehicle network by remote command centers; 

allowing the remote tuning of avionics configurations by an expert. 

 

The primary ground station that remote terminals would connect to must have been network enabled by selecting 

Advanced->Network Interface->On from the top menu bar. After the Remote Terminal Mode is chosen when 

prompted to select the operation mode, another small window titled “GroundStation TCP/IP Connection” appears 

to request the IP address and network interface port of the ground station that this remote terminal would connect 
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to. The default IP address for the ground station is 127.0.0.1, which is the local machine itself (basically to test 

the remote terminal feature on the same machine). The default network interface port is 5701. 

 

After the remote terminal connects to the primary ground station, the former requests the later to send custom 

landmarks, draft trajectories and all avionics configurations. But the ground station configuration is not requested 

so the remote terminal can have a different setup, for example, to select a different focus vehicle, or to look at a 

different area of the moving map. 

 

The remote terminals have equal access and control of the vehicle network as the primary ground station. All 

remote terminal commands are actually sent to the primary ground station, with the results broadcast to all 

remote terminals. All vehicle telemetry data are also broadcast by the primary ground station so the remote 

terminals would be up to date as well. 
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4.3.2 Moving Map 

A moving map occupies the central real estate of the operator interface. There are three types of moving maps to 

choose from: 

 AtlasTopo – Topographic map of the world converted with the utility program AtlasMapMaker, which was 

customized based on the open source program Atlas (In compliance with the GNU General Public License, 

the source code of AtlasMapMaker is freely available upon request from Aerojeep). AtlasMapMaker 

converts all terrain data of the FlightGear flight simulator to produce normal (256x256 pixels) and low 

resolution (64x64 pixels) map files for each 1x1 degree square and place them under the 

data\Maps\AtlasTopo folder. FlightGear terrain is based on 90m SRTM data and is very detailed. Any parts 

of the world can be downloaded from www.FlightGear.org. 

 StreetMap – When internet connection is available, a street map that covers the moving map area can be 

automatically downloaded from Google Maps by 

choosing “Download Google Maps” from the 

Advanced main menu. Alternatively users could 

provide their own street maps. Each .png file under 

data\Maps\StreetMap folder must have 2n (64, 128, 

256, 512, 1024 etc.) pixels on each side. The 

coordinates of the top left and bottom right corners 

of the street map must be defined by a coordinate 

file of the same root name with .gri extension. All 

map files under the data\Maps\StreetMap directory 

are loaded, with higher resolution maps loaded later 

to overlay on top of lower resolution maps that can 

cover larger areas. Users should remove or save 

unused map files from data\Maps\StreetMap directory as too many map files could negatively impact the 

responsiveness of the ground station. 

 AerialPhoto – When a street map is downloaded from 

Google Maps, a hybrid aerial photo map covering the 

same area is also downloaded and saved under the 

data\Maps\AerialPhoto directory. Users can provide their 

own aerial photo files, each with a coordinate file of the 

same root name with .gri extension. Aerial photo map 

files should be handled in the same way as described 

earlier for the street map files. 

 

An instrument panel with an altimeter, artificial horizon and 

speedometer can be found under the moving map. The 

altimeter shows the altitude of the focus vehicle in hundreds 

 

Figure 4-6 Moving Map – StreetMap Type 

 

Figure 4-7 Moving Map – Aerial Photo 
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of meters with a maximum of 900 meters; if the altimeter reads 900 meters, the real altitude could be higher, 

which can be read in the avionics window. The speedometer shows the focus vehicle’s ground speed in 

kilometers per hour with a maximum of 170 km/h. Higher ground speed must be read through the avionics 

window. 

 

A message panel to the right side of the speedometer displays events that might need operator’s attention. If an 

event must be dealt with right away, an alert window will pop up. 

 

A moving map control panel is located near the top right corner of the operator 

interface. The latitude and longitude of the cursor is shown at the top. The Map 

Type selector allows a user to switch between the three map types at any time. The 

user can also select one of three map representations: Sanson Flamsteed, local and 

equatorial. Map grid lines can be turned on or off.  

 

If “Center Focus Vehicle” is checked, the focus vehicle is locked in the center of 

the map, while the moving map moves around it. It provides a convenient way to 

quickly “find” the focus vehicle when, for example, a new focus vehicle is chosen. 

 

The four symbol buttons just above “Center Focus Vehicle” checker box let users 

select the pointer mode of the moving map: 

 If the first arrow button is pressed, a user can select and edit objects such as 

custom landmarks, vehicles, waypoints and trajectories by clicking on them or drag and trop;  

 When the second amplifier button is pressed down, a left mouse click inside the moving map would place 

the point of click at the center and zoom in by 50%, while a right mouse click would place the point of click 

at the center but zoom out by 50%. A User can also hold down the left mouse then drag and release to take a 

closer look inside the dotted rectangular box. 

 If the third pan symbol button is pressed down, the moving map can be moved with a left mouse press, drag 

and release sequence. 

 Pressing down the last symbol button would lock down the moving map to prevent unintentional changes 

while, for example, the operator is taking a break. 

 

Figure 4-8 Moving Map 

Control Panel 
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4.3.3 Public and Custom Landmarks; “Swarming” Strategy 

Public landmarks with over 20,000 real world airports and other 

navigation aids are compiled based on publicly available data by 

the good people who contributed to the FlightGear open source 

project. The data\PublicLandmarks folder includes the database 

files for airports and navaids. Users should refer to the 

FlightGear project for more details on these databases, to obtain 

updates, or to learn how to add their own data to these database 

files. As far as BrainyBEE ground station is concerned, these 

public landmarks are there for visual effects only, and can not be 

edited through the operator interface. 

 

In addition to public 

landmarks, users can define four types of custom landmarks: Location, 

Target, Threat and Runway. To define a new landmark, first make sure the 

moving map is in edit mode by pressing the pointer button in the moving 

map control panel. Then press right mouse button to open a popup menu, 

select “New Landmark…” to open the landmark edit window. Latitude 

and longitude fields have been automatically filled with the location of the 

mouse cursor when the popup menu was opened. Other input fields 

include: a 16-bit integer id, name, type, altitude. If the landmark type is 

runway, then runway length, width in meters as well as heading need to be 

set; for other landmark types, a priority and radius in meters should be set. 

 

From the top menu bar, 

select “View->Custom 

Landmarks…” would 

open the Custom Landmarks list window. Double click on an 

item in the list would open the landmark edit window. 

Landmarks can be added or deleted with the Add and Delete 

buttons. 

 

Custom landmarks help users design flight plans and improve 

situational awareness relative to previously known positions. 

When the moving map is in edit mode, right click to open a 

popup menu; if “Snap Landmark… On” is chosen, then a 

waypoint can be dragged near a landmark and snap to it, 

taking its longitude, latitude and altitude. Radius around a landmark could be used to define a visual flight 

 

Figure 4-9 Public and Custom Landmarks 

 

Figure 4-10 Custom Landmark 

Edit Window 

 

Figure 4-11 Custom Landmark List 
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boundary. Runway landmark type allows a user to define a runway anywhere, be it in a local park or in his own 

backyard. 

 

The custom landmark feature is also designed to support advanced capabilities such as autonomous trajectory 

generation. A third-party optimal trajectory generation software would connect to the ground station through 

network interface, and communicate in the same protocol as a remote ground station. The trajectory generation 

software would presumably take into account the radius and priority of the target and threat landmarks, and other 

system constraints such as vehicle minimum and maximum velocity, turn radius etc. to compute optimal 

trajectories for a network of UAVs that produce the maximum coverage of the targets while staying away from 

the threats. The optimal trajectories are computed in real time and sent to the UAV network periodically. Such is 

the thesis behind the “swarming” strategy, with one or a few operators set high mission goals only and leave 

flying each UAV to the autonomous flight control system. When some UAVs 

are lost due to refueling or enemy fire, other vehicles will partially fill the void 

as optimal trajectories are re-calculated. Implications for military and civilian 

applications are significant and obvious, examples including highway and 

border patrol, battlefield surveillance and aerial attacks. 

 

Public and custom landmarks can be selectively turned on and off by flipping 

the check boxes in the landmark control panel. If the moving map is crowded 

with objects such as landmarks, flight trajectories, etc., the operator interface 

could be hard to read or even sluggish to user commands, then some features 

should be turned off. 

 

Figure 4-12 Landmark Control 

Panel 
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4.3.4 Draft Trajectories 

A flight trajectory consists of a single linked list of waypoints. Each waypoint is defined with properties 

including type, position, target velocity, and the index of the next waypoint. Every flight trajectory must be 

closed, i.e. every waypoint must have a valid next waypoint field.  

 

BrainyBEE avionics controller can store up to 100 waypoints, regardless of how many flight trajectories they 

define. Through the operator interface a user can modify, add or delete a waypoint from an existing trajectory 

already stored in the BrainyBEE avionics controller. However, to avoid fatal errors, any new trajectory must be 

drafted on the ground station first before uploaded to the BrainyBEE avionics controller. More details on 

waypoints and their use can be found in Section “4.3.6.2 Guidance Tab”. 

 

To edit draft trajectories, the operator interface must enter the trajectory draft mode. First place the operator 

interface in edit mode by pressing the pointer arrow in the right panel just over the “Center Focus Vehicle” line. 

Now move the mouse cursor inside the moving map. Click the right mouse to bring up a pop up menu and select 

“Enter Trajectory Draft Mode”. The “Draft” check box in the right panel under the “Trajectory” group is 

automatically set to show existing draft trajectories in yellow lines. 

 

To add a new draft trajectory, click the right mouse and select “New Trajectory…”. A highlighted symbol of the 

implied waypoint type appears under the mouse cursor. A right mouse click would bring up the waypoint edit 

window to show the property of the implied waypoint to be added. Modify if necessary then click “OK” to exit 

the waypoint edit window. A left mouse click would add a waypoint with the implied properties at where the 

mouse cursor is. Repeat with left mouse clicks until all waypoints for the trajectory have been defined. To close 

the trajectory, move the mouse cursor over an exiting waypoint, quickly double click the right mouse to end the 

trajectory with this waypoint. If the mouse cursor is not near any existing waypoint when the right mouse is 

double clicked, then the new draft trajectory would close with the first waypoint in this trajectory. 
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Figure 4-13 Draft Trajectories 

A waypoint can be moved simply by dragging it while keeping the left mouse pressed down. To modify other 

properties, open the waypoint edit window by double clicking the waypoint. To delete or append waypoints, 

select the waypoint with a left mouse click, then click the right mouse to open a pop-up menu then select the 

intended action. 

 

All draft trajectory waypoints can be viewed from the top menu bar “View->Draft Trajectories…”. Double 

clicking on an entry in the list would open the waypoint edit window. 

 

Left mouse click on a yellow line would highlight the trajectory the line belongs to. Right mouse click would 

bring up the pop-up menu with possible actions including: 

 New Trajectory – Build a new trajectory from scratch. 

 Draft Area Scan Trajectories – Open a dialog window to define area scan trajectories, with inputs including 

altitude, velocity, segment direction, length and spacing, and number of segments. Payloads can also be 

configured to trigger at regular intervals, with up to 1600 trigger events logged in the flash memory if the 

trigger log function is enabled on the Payload Tab. 
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 Delete Trajectory – delete the highlighted trajectory. 

 Delete All Waypoints – delete all draft waypoints. 

 Reorder Waypoints – re-order the waypoint indices of all draft trajectories. 

 Upload Selected Draft Trajectory – Upload the highlighted trajectory to the focus vehicle. 

 Upload All Draft Trajectories – Upload all draft trajectories to the focus vehicle. 

 Load Draft Trajectories – Add draft trajectories from file data\GroundStation\GroundStation.wpt. A user can 

rename a previously saved waypoint file to GroundStation.wpt to be added as new draft trajectories. 

 Store Draft Trajectories – Save draft trajectories to data\GroundStation\GroundStation.wpt. 

 Exit Trajectory Draft Mode – exit trajectory draft mode, to enter the operator interface edit mode. 

 

When trajectory drafting is finished, do not forget to exit the Trajectory Draft Mode by clicking the right mouse 

then selecting “Exit Trajectory Draft Mode” from the pop-up menu. 
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4.3.5 Vehicle Network 

Each BrainyBEE avionics controller is assigned a unique 16-bit vehicle id at factory which can not be changed. 

A UAV carrying a BrainyBEE avionics controller must be added to a BrainyBEE UAV network by creating a 

vehicle object with the unique vehicle id through the operator interface. 

4.3.5.1  Vehicle Network and Focus Vehicle 

From the top menu, select “View->Vehicle Network…” would open 

the vehicle network window that lists all the vehicles currently in the 

network and their types and status. Vehicles can be added or deleted 

with the Add and Delete buttons. Double clicking an item would 

open the Avionics Window which will be described in detail in the 

next section. Pressing “Upload All Configs” button would send all 

avionics configurations in memory to respective BrainyBEE 

avionics controller; “Download All Configs” button downloads 

configurations from each BrainyBEE avionics controller to ground 

station memory. “Store” button would save all avionics 

configurations currently in memory to avionics configuration files. 

“Load” button would retrieve avionics configurations from avionics 

configuration files on the hard drive. When the BrainyBEE operator 

interface exits “normally”, the ground station and all avionics 

configurations are automatically saved to the configuration files. 

Next time the BrainyBEE operator interface starts in software 

simulation or flight control mode, it first loads the configuration 

files. Then in the case of flight control mode, the ground station will attempt to synchronize with each 

BrainyBEE avionics controller on the vehicle list by downloading the avionics configurations. More descriptions 

are available in the next section on avionics window. 

 

There is also a focus vehicle list located at the bottom left corner of the 

operator interface. The highlighted vehicle on the focus vehicle list is the 

focus vehicle that receives all commands issued through the operator 

interface. A new focus vehicle can be selected by double clicking on that 

vehicle entry in the focus vehicle list. A confirmation window opens to 

confirm if this vehicle should be selected as the new focus vehicle, and 

the avionics window opens. 

 

Figure 4-14 Vehicle Network Window 

Figure 4-15 Focus Vehicle Window 
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4.3.5.2  Communicating with the UAV Network 

The BrainyBEE ground station communicates with the UAV network by passing data packets via the wireless 

serial data modems. To avoid data collision during aerial transmission, a simple polling scheme is deployed 

whereby the BrainyBEE ground station alternatively polls the focus vehicle and one vehicle in the network for 

real-time telemetry data. This simple and effective method guarantees that the focus vehicle occupies at least 

50% of communication bandwidth for adequate real-time updates. 

 

Every data packet includes a vehicle id that identifies the destination or source of the data packet. Each 

BrainyBEE avionics controller only processes data packets with the same vehicle id as its own. There is a 

separate command data buffer to store operator commands. For optimal responsiveness, the BrainyBEE ground 

station always sends all command data packets in the command buffer, regardless of the destination, before 

sending polling packets to the next vehicle. After sending out a data packet, the ground station would wait for a 

maximum of 0.2 second for a return packet. If a return packet was not received within 0.2 second, 

communication with that vehicle is considered broken, and all remaining data packets in the command buffer for 

that vehicle is deleted to minimize impacts on communications with the other vehicles. Hence inactive vehicles 

should be removed from the ground station vehicle network to avoid unnecessary communication delays which 

would negatively impact the effective communication bandwidth and responsiveness to operator commands. 

 

Every data packet includes error checking bytes. There are two running communication counters in the left panel 

of the operator interface: the Frame Count shows the running count of good data packets received by the ground 

station; while the Error Count shows the number of bad or missing return packets. The frame counter turns red 

for warning if it is unchanged between screen refreshes. The error counter turns red when it is incremented. 
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4.3.6  Avionics Window 

The BrainyBEE autopilot design follows the familiar navigation, guidance and control paradigm. The 

configuration and telemetry data are grouped by category. The telemetry data are periodically polled in real-time 

from the BrainyBEE autopilot for display at the operator interface; they are not stored permanently except for in 

the log file.  

 

In contrast, the autopilot configurations reside in both memory and permanent storage (which is the flash 

memory on the BrainyBEE autopilot, and the hard drive at the ground station). Upon start, the operator interface 

automatically loads all configuration files on the hard drive. However, in the flight control mode, the operator 

interface will then attempt to synchronize with each BrainyBEE autopilot by polling its configurations. All 

configurations are saved to the configuration files when the operator interface exits. On the BrainyBEE autopilot, 

the configurations are saved into the flash memory whenever changes are made. 

 

On the ground station, the autopilot configurations are stored in several configuration files in the 

data\VehicleNetwork folder. Every vehicle has its own configuration files, identified as vehicleN.xxx, where N is 

the vehicle id, and .xxx identifies the configuration types including the following: 

 .cfg – General information including vehicle id, name, type, etc. 

 .nav – Navigation configuration file. See details in Section 4.3.6.1  Navigation Tab. 

 .sns – Sensor configuration file. See details in Section 4.3.6.1  Navigation Tab. 

 .gud – Guidance configuration file. See details in Section 4.3.6.2  Guidance Tab. 

 .wpt – Waypoints that define flight trajectories. See details in Section 4.3.6.2  Guidance Tab. 

 .cnt – Control configuration file. See details in Section 4.3.6.3  Control Tab. 

 .act – Actuation configuration file. See details in Section 4.3.6.4  Actuation Tab. 

 .pld – Payload configuration file. See details in Section 4.3.6.5  Payload Tab. 

 

The BrainyBEE configuration files are all text-based, and can be read and modified with any plain text editor. 

But with a few exceptions noted in related sections, it is highly discouraged to modify these files by hand, 

because an accidental error could cause system instability. It is the user’s responsibility to backup configuration 

files and folders as they see fit in case they need to restore the configurations to a previously working state. 

 

The avionics window displays the status, telemetry and configurations of a BrainyBEE autopilot. It must be 

opened to configure the autopilot. (All functions related to normal vehicle operation can be accessed from pop up 

menus on the main display window. To simplify the windows display during normal operation, the avionics 

window can be hidden by choosing “Advanced->Autopilot Config…Hide”. To safeguard autopilot 

configurations from accidental changes during normal flight operations, click “Lock Config” button to provide a 

configuration protection password.) The avionics window can be opened by double clicking a vehicle’s symbol 

in the moving map, or double clicking its entry in the vehicle network window or the select focus vehicle 

window.  
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The top section of the avionics window shows the general information that does not fall under other sub-groups: 

 Name – Each vehicle has a name for the convenience of the user. It has no functional significance for the 

BrainyBEE flight control system, since the vehicle id is the only recognized identification. Type name and 

press enter will upload the new name to the BrainyBEE avionics controller for storage in its flash memory. 

 Voltage – Shows the voltage of the battery providing power to the avionics board. 

 Volt. Threshold – If enabled, the voltage field would turn red for warning if the voltage drops below the 

threshold. Enter new threshold value and press enter to upload the change to the BrainyBEE avionics. 

 

It looks rather surprising at first that there is no vehicle id or vehicle type fields in the general information 

section, although the vehicle id, name and type are displayed in the title bar of the avionics window. The reasons 

become obvious when the process of “creating” a new vehicle is understood. 

 

The BrainyBEE ground station operator interface only attempts 

to communicate with BrainyBEE avionics that is included in its 

vehicle network. Hence to add a BrainyBEE avionics to the 

vehicle network, a new vehicle with the avionics id must be 

created first. There are two ways to open a “New Vehicle” 

window: move the mouse cursor inside the moving map, click 

the right mouse then choose “New Vehicle…” from the pop-up 

menu to open the “New Vehicle” window; The second method 

is to open the vehicle network window by selecting from the top 

menu bar “View->Vehicle Network…”, then press the Add 

button in the Vehicle Network Window. 

 

In the New Vehicle window, type the unique avionics controller 

id as the vehicle id, type a name, choose a vehicle type, and 

provide an initial position, then press the “Create” button to add 

a new vehicle with its configurations set to default values for its 

vehicle type. Then you can modify its properties by opening the avionics window. Alternatively you can copy 

your existing configuration files and rename them for this vehicle, from the top section of the avionics window, 

press the All Vehicle Config Files->Load button, then the “Upload All Configs” button to upload new 

configurations to the BrainyBEE avionics controller. 

 

Since different vehicle types have very different configurations, simply changing the vehicle type could cause 

fatal accidents. So we made it “especially difficult” for a user to change the vehicle type of a BrainyBEE 

avionics controller.  

 

Follow there steps to change a vehicle type: 

Step A) Exit operator interface; restart in Software Simulation mode. Highlight the vehicle symbol in the 

moving map with a left mouse click, then click the right mouse and select “Delete Vehicle…” from the pop 

 

Figure 4-16 New Vehicle Window 
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up menu, confirm to delete the vehicle. Alternatively, highlight the vehicle in the vehicle network window 

then click the Delete button. 

Step B) Create a new vehicle with the same avionics id and choose a new vehicle type. Exit operator interface 

and the new configurations will be saved on hard drive. Restart operator interface in Flight Control mode. 

The operator interface will attempt to synchronize with the BrainyBEE avionics and download its 

configurations including the old vehicle type. 

Step C) Open the avionics window, from the top section, press the All Vehicle Config Files->Load button to 

load the new vehicle configurations from the configuration files on the hard drive into the memory of the 

ground station computer; Then press the “Upload All Configs” button to upload all configurations including 

the new vehicle type to the BrainyBEE avionics controller, which will store the new configurations in the 

flash memory. 

Step D) The new configurations can be edited with the avionics window. Alternatively, a user can rename 

previously saved configuration files for this vehicle then press the All Vehicle Config Files->Load button, 

then the “Upload All Configs” button to upload new configurations to the BrainyBEE avionics controller. 

 

Under the general information section of the avionics window, there are several tabs that can be pressed to view 

and edit their respective telemetry and configuration data. Details are explained in their own sections below. 
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4.3.6.1  Navigation Tab 

The BrainyBEE avionics controller is 

the world’s first single DSP solution that 

runs a robust scalable multi-state 

extended Kalman Filter to fuse IMU 

(Inertia Measurement Unit) sensor 

inputs with GPS data to extract 

wide-bandwidth attitude for high 

performance dynamic control and 

guidance. Furthermore, due to the 

recursive nature of the Kalman Filter, 

the BrainyBEE avionics controller is 

readily customizable to accept additional 

inputs such as an altimeter, custom GPS, 

or laser gyro for additional performance 

enhancement. 

 

If an air pressure sensor is detected, the 

current air pressure as well as 

temperature is displayed in the top of the 

avionics window. The air pressure 

sensor can be activated as an altimeter, 

as the GPS vertical positioning could be 

unsatisfactory when in close range to the ground. An altimeter bias should be provided to display the correct 

altitude. 

 

Under the Navigation Tab, there are three display sub-regions: GPS, IMU, and Kalman Filter. Most fields are 

self-explanatory. Filtered raw accelerometer and magnetometer data are displayed, while the gyro angular rates 

are corrected with drifting biases estimated by the Kalman Filter. When the Kalman Filter runs in the full state 

mode, position, velocity and heading shown under the GPS group actually display the respective Kalman Filter 

states, which are basically GPS data corrected by the Kalman Filter with the help of the other sensor inputs. 

 

The GPS Dilution of Precision is a standard measure of GPS precision. Smaller DOP value indicates higher 

precision. Do not fly in the autonomous mode if the DOP is higher than 4. Autonomous tracking can not be 

started unless the GPS status is 3D-Fix. The green LED on the BrainyBEE avionics controller also shows the 

GPS status: it’s off when there is no GPS lock; dim green when GPS is in 2D fix or there is inconsistency in the 

accelerometer and magnetometer readings; it’s bright green only when GPS has reached full 3D fix mode and the 

IMU sensor readings passed consistency check. 

 

Figure 4-17 Navigation Tab 
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If the GPS does not reach the 3D-fix status, the Kalman Filter can only work in the attitude-only mode. With 

GPS 3D-fix, the Kalman Filter can produce full state estimates including attitude, position and velocity. 

Consequently autonomous tracking is only possible when the Kalman Filter works in full mode with GPS 3D-fix. 

To ensure that the Kalman filter works reliably near or inside a building where the GPS signal is bad, the Kalman 

filter runs in attitude-only mode under manual control; A pilot should not switch to the autopilot mode until the 

vehicle has the clear view of the sky, when the Kalman filter can run in the full state mode to provide both 

attitude and positioning outputs. 

 

The “Trace” field in the Kalman Filter sub-region is an important health indicator of the underlying mathematical 

algorithms involving very complex and computationally intensive matrix operations. After initial start, the trace 

value should remain small and stable. The Kalman Filter will automatically reset if the trace value becomes 

negative or too large. If the Kalman Filter produces unreasonable values, it can be reset manually by pressing the 

“reset” button. The Kalman Filter is very robust. If it ever resets itself or requires manual reset, the underlying 

problem must be diagnosed. It could be the result of erroneous sensor outputs, external magnetic interferences 

etc. For example, modern buildings use a lot of ferromagnetic materials such as steel, so magnetic sensors might 

work poorly indoors. 

 

Small and low-cost MEMS gyros deployed in virtually all micro avionics controllers drift slowly with 

temperature. The powerful DSP on the BrainyBEE avionics controller generates quite a bit of heat, hence the 

gyros could develop considerable drifts after initial power on when the board was cool. The gyro drifts are 

estimated by the Kalman Filter and shown in the Gyro Bias fields. 

 

The BrainyBEE avionics controller should be placed close to the center of gravity (CG) of the vehicle. If the 

avionics controller must be placed away from the CG due to physical constraints or environmental considerations 

such as to avoid heat and vibration, the displacement from the CG should be specified in the “Avionics Offset” 

fields so the discrepancy can be partially compensated in software. The offsets should be measured from the CG, 

and follow the customary aircraft body reference frame convention where the positive X-axis points to the nose, 

Y-axis points right, and Z-axis points down. 

 

Similarly, the displacement of the GPS antenna from the vehicle CG can be specified in the GPS Offset fields. 

 

The BrainyBEE avionics controller should stay away from ferromagnetic materials that could distort the 

magnetometer readings. The distortions could come in two types: hard-iron and soft-iron. Soft-iron is nonlinear 

and difficult to correct. Hence for the current release only the hard-iron error can be specified and corrected with 

the BrainyBEE avionics controller. The hard-iron error is the result of a body-fixed magnetic source 

superimposed with the Earth’s magnetic field. Simply rotate the vehicle by 180 degrees around one of the three 

principal axes of the vehicle, and take the average of the two readings before and after the rotation in one 

diagonal direction and set as the hard-iron for that direction. Try repeatedly until the two readings are equal but 

opposite in signs when rotated 180 degrees. Repeat the procedure for the other two directions. 
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The expected local magnetic field must be known by the BrainyBEE avionics controller to be compared with the 

measured values. When the GPS is locked after power on, the expected local magnetic field is calculated for the 

current longitude and latitude based on the United States Department of Defense’s World Magnetic Model. If the 

vehicle is placed flat with respect to the ground while the nose pointing to the North, and the magnetic hard-iron 

has been corrected, yet the Magnetometer reading differs more than 10% from the expected values based on the 

WMM model, then the local magnetic field might have been distorted, such as the case inside a building. The 

Kalman Filter is quite robust. As long as the magnetic field does not change rapidly, the Kalman Filter should 

produce stable attitude, even though the heading might be off a bit such as inside a building. 

 

The accelerometer and magnetometer readings are put through simple consistency checks. If their magnitudes 

are respectively more than 15% and 10% off their expected values, the readings background turns yellow for 

warning. Furthermore, the angle between the measured gravity and magnetic field is compared with the expected 

angle. If the difference is more than 15 degrees, the magnetic readings background also turns yellow. It is evident 

that the consistency check would produce erroneous warning when the vehicle experiences moderate rotation or 

accelerations. Thus take them only as a warning when the vehicle is in flight. However, if the consistency check 

fails while the vehicle sits still on the ground, then the problem must be corrected before flight, or the Kalman 

Filter could malfunction. 

 

The navigation configuration file vehicleN.nav stores the settings for the avionics and GPS offsets, magnetic 

hard-iron, and the expected magnetic field. Pressing the “Upload Navigation Config” button to upload new 

values to the BrainyBEE avionics controller and store in its flash memory. Press the “Download Navigation 

Config” button to download the current settings from the BrainyBEE avionics controller. The Navigation Config 

File Store and Load buttons save the settings to and load from the vehicleN.nav file respectively. 

 

Sensor input filtering cutoff frequencies must be configured properly. Generally speaking, inherently unstable 

platforms such as X4flyer require high cutoff frequencies, while vehicles with strong vibration necessitate low 

cutoff frequency in addition to mechanical vibration damping. The choice of roll and pitch cutoff frequencies is 

particularly tricky as well as critical for the helicopters, which have strong low frequency vibrations due to rotor 

and body interactions. Default cutoff frequencies are set automatically for different vehicle types, and they are 

saved as CutoffFreq fields in the vehicleN.nav file. For clarity, they are not displayed under the navigation tab, 

and must be edited directly in the vehicleN.nav file if necessary. After any change is made and file is saved, load 

the vehicleN.nav file, then upload the new configuration to the vehicle. 

 

When the BrainyBEE avionics controller is connected and synchronized with the BrainyBEE ground station, its 

sensor calibration and Kalman Filter covariance parameters are downloaded and saved to the vehicleN.sns file in 

the data/VehicleNetwork folder. These parameters are calibrated and tested at factory for every BrainyBEE 

avionics controller, and EXTREAM care must be taken when making any changes to them. Always backup the 

sensor file before making changes so they can be restored if necessary. After editing and saving vehicleN.sns file, 

upload the new configuration by pressing the “Sensor Config File: Upload” button. 

 

The Kalman Filter is quite robust and would work even if IMU sensor measurements are 10% or more off their 
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true values. However, better calibrated sensors would lead to higher precision navigation and control. If you 

believe that you are competently knowledgeable with the workings of the IMU sensors, the following 

information is helpful for you to adjust these parameters. For most other users, do not bother to read this 

information, and you could send the BrainyBEE avionics controller back to us for diagnosis and re-calibration if 

that is necessary. 

 

To set gyro scale parameter, first check “Enable” for Actuation Calibration under the Actuation Tab (See 

Actuation Tab Section to find out when calibration can be enabled); now the gyro readings in the IMU 

sub-region shows the gyro rate integrals. (Raw gyro rate measurement is used, since the Kalman Filter is turned 

off during sensor calibration. If the gyro reading drifts, press Kalman Filter->reset would reset the gyro neutral.) 

Now rotate the BrainyBEE avionics controller by 90 degrees around one of the principal axes. If the integrated 

angle reading for that axis is not 90 or -90 degrees, modify the gyro scale. Repeat the procedure for all three 

axes. 

 

Each direction of the accelerometer has two parameters: scale and zero. First set the Z-axis parameters. Make 

sure the BrainyBEE avionics controller is flat with respect to the ground. The Z-axis reading should be close to 

-9.8 m/s/s. Now turn the BrainyBEE upside down. The Z-axis reading now should be close to 9.8 m/s/s. Adjust 

the zero parameter first until the two reading are equal but opposite in sign. Then adjust the scale parameter so 

the z-axis now reads -9.8. Now repeat the process for the X-axis and Y-axis by first turning the BrainyBEE 

avionics controller on one of its sides. 

 

To calibrate the magnetic sensor, make sure you are not near any ferromagnetic materials. For example, you 

probably need to step outside if your building has steel frames. Now place the avionics flat on the ground while 

the nose points the North. Compare the magnetometer readings with the expected values from the WMM model. 

It’s a matter of rotating the avionics controller by 180 or 90 degrees around each of its principle axes and 

adjusting the zero and the scale parameters until the values read right. 
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4.3.6.2  Guidance Tab 

The BrainyBEE autopilot is very versatile 

and can operate in manual control mode or 

autopilot mode. The autopilot mode in turn 

has three sub-modes: fully autonomous 

tracking, tracking with manual steering, or 

velocity control. 

 

Four types of manual input devices can be 

selected from the Guidance Tab: the 

integrated receiver, an external receiver of 

customer’s choice, a Joystick game 

controller that connects to the USB port, or 

the sliders just below the moving map. A 

joystick game controller usually is used for 

computer games such as flight simulators. 

Various adapters are commercially available 

to turn a normal radio transmitter with a 

trainer port into a joystick game controller. 

Select “View->Joystick Mapping” to set the 

channel mappings and polarities. When used 

for the first time, the Joystick controller 

should be calibrated by selecting “Control 

Panel->Printers and Other Hardware->Game Controllers”, then select the controller before clicking "Properties”. 

 

When the sliders are not selected as the input device, they are turned gray but still display the current manual 

input values. It is critical that the control sticks on the joystick game controller or the radio transmitter are set 

with correct polarities: Select one of them as the input device, move one of the control sticks, the corresponding 

slider under the moving map must move in the same direction; otherwise, the polarity of the control stick must 

be reversed. 

 

Radio transmitters send square pulses ranging from 1ms (millisecond) to 2ms in width for each control channel. 

1.5ms is usually the neutral point for the roll, pitch and yaw control sticks unless the trim tabs have been adjusted. 

To accommodate all the varieties of radio transmitters out there, the BrainyBEE avionics controller reads the 

channel inputs in fixed range from 1.2ms to 1.8ms for the throttle channel, and 1ms to 2ms for all other control 

channels. Hence, throttle channel pulse width less than 1.2ms is read as 0% throttle, while throttle channel pulse 

width of more than 1.8ms is read as 100% throttle. For gas powered aircraft, it is the user’s responsibility to 

adjust the throttle curve on his transmitter so that the engine can be turned off or placed in idle by moving the 

Figure 4-18 Guidance Tab 
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throttle trim tab while the throttle stick is pulled low. 

 

The roll, pitch and yaw servos on a remote controlled hobby model plane are usually moved directly with their 

respective control sticks. In comparison, in the BrainyBEE flight control system, the roll, pitch and yaw control 

sticks provide reference angular rates in trajectory tracking mode, or reference velocity in velocity control mode. 

 

Channel 5 on a hobby transmitter or on a Joystick game controller is usually a switch and is used to select 

between the manual control mode and the autopilot mode. (If the input device is Slider, then the control mode 

can be flipped by clicking the AutopilotMode/ManualMode button next to the rudder slider under the Altimeter.) 

In the manual control mode, the inner control loops are always activated for unstable VTOL platforms like 

X4flyer to provide stability augmentation; for fixed wing aircraft or helicopter, the inner control loops can be 

optionally activated. The yaw control is always open loop (i.e. moved directly with the yaw stick) for a fixed 

wing aircraft under manual control, so that the aircraft can make a turn with only roll command as usual. Had the 

yaw closed loop control is on, the rudder would fight the turn initiated by a roll command, unless a simultaneous 

yaw command is also present. For other vehicle types, the pilot should coordinate the roll and yaw stick controls 

to make a turn. 

 

If the Channel 5 switch is rapidly flipped between autopilot and manual control modes twice (i.e. back and forth 

for four times), initial trims as shown on the Control Tab are set. This is very important for takeoffs in manual or 

velocity control mode. For autonomous tracking mode, initial trims are automatically set before tracking starts. 

(Note: If the Manual Input Device is radio transmitter, when Channel 5 is quickly flipped twice, the current roll, 

pitch and yaw stick positions are also set as neutral reference points; Furthermore, if the Channel 5 switch on the 

transmitter is quickly flipped three times, the transmitter’s roll, pitch and yaw trims are read to set the roll, pitch 

and yaw trims respectively. These two features are only available for the radio transmitter, to make it more 

convenient when flying without a ground station. If the input device is a joystick game controller, the initial trims 

must be set on the control tab instead, and the input device’s trim tabs must be placed in neutral positions such 

that the current trim values do not change when the vehicle sits still on the ground. This is because that unlike the 

radio transmitter, which works one on one with a single vehicle, the joystick game controller or the slider inputs 

must work with any vehicle selected as the focus vehicle. It should also be noted that a small dead band is 

defined around the neutral points.) 

 

For rotary wing aircraft including helicopter and multirotor aircraft, a return to home base feature can be 

activated with channel 6. First, channel 6 must be flipped from normal to return then back to normal mode to 

activate and set the return point. In autonomous mode when channel 6 is flipped to the return mode, the aircraft 

would fly back toward the return point. Note that it is the pilot’s responsibility to ensure the flight path to the 

return point is clear of obstacles. There’s a special case designed for autonomous takeoff. If the throttle is at zero 

level while in manual mode, flipping channel 6 from normal to return then back to normal mode would set the 

return point to 5 meters above current position, hence autonomous takeoff can be performed by flipping channel 

6 to return mode and channel 5 to autonomous mode. To return to normal autonomous mode including velocity 

or trajectory tracking, simply flip channel 6 to the normal mode. 
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Commercially available motor controllers usually have a “safety arming” feature which keeps the engine from 

running until the transmitter throttle stick has been pulled low for a few seconds. However, to ensure smooth 

transition between autopilot and manual control modes at any time, there is NO “safety arming” feature on 

BrainyBEE avionics controller in the manual control mode. Hence the user MUST make sure the throttle 
stick is pulled low before turning on the power. 
 

As an important reminder, a fully autonomous aircraft is almost never supposed to perform anything acrobatic. In 

fact, doing so (even in manual control mode) could disrupt the GPS and the communications link, and could lead 

to instability and failure of the all important attitude tracking function by the extended Kalman Filter. 

 

If the autopilot mode is turned on by flipping Channel 5 switch on a hobby transmitter or on a Joystick game 

controller, one of three sub-modes can be selected under the “Autopilot with Manual Mix” group: 

 Trajectory Tracking/Manual Input Disabled – Vehicle flies in fully autonomous mode by following a 

pre-defined trajectory consisting of waypoints. The vehicle altitude shall track the slope connecting the 

consecutive waypoints. No manual steering is available. If GPS loses lock, the Kalman Filter falls back to 

attitude only mode and can no longer track the trajectory, the vehicle attitude and throttle level shall be 

maintained until GPS locks again. (When the BrainyBEE ground station is run in Software Simulation 

mode, double clicking the Mode:Attitude field under the Kalman Filter group would simulate the loss of 

GPS and allow a user to practice how to react, particularly if the FlightGear or X-Plane flight simulator is 

connected) 

 Trajectory Tracking/Manual Steering – Vehicle flies in fully autonomous mode by following a pre-defined 

trajectory consisting of waypoints. The vehicle altitude shall track the slope connecting the consecutive 

waypoints. The pilot can steer the vehicle slightly off track with the yaw stick on the activated manual input 

device; Reference velocity can be temporarily modified with the pitch stick for helicopter and VTOL in 

hover, and with the throttle stick for fixed wing in forward flight. For helicopter and VTOL in hover mode 

(over a Hover waypoint, or Takeoff or Landing waypoint with zero target velocity), the vehicle can be 

moved slightly forward or sideway with the pitch and roll stick respectively, while its heading can be 

re-directed with the yaw stick. The throttle stick input now slightly modifies the target climb rate (by at 

most 2 m/s) or target altitude (by as much as 10 meters). The throttle stick position when switched from the 

manual mode is set for zero climb rate for VTOL, or no change in reference velocity for fixed-wing. If the 

GPS loses lock, the Kalman Filter falls back to attitude only mode and can no longer track the trajectory, the 

throttle level shall be maintained while the vehicle can still be manually steered until GPS locks again. 

 Tracking Disabled/Manual Velocity Control – The vehicle flies in semi-autonomous mode by tracking the 

reference velocity or reference position. The throttle stick now provides the reference climb rate in the range 

of maximum and minimum climb rates defined on the Guidance Tab for helicopter or VTOL in hover, or 

change in reference velocity for fixed wing aircraft (The throttle stick position when switched from the 

manual mode is set for zero climb rate or no change in reference velocity). The heading is directed with the 

yaw stick. For non fixed-wing vehicle, a “Hover to Forward Flight Transition Velocity” must be defined on 

the Guidance Tab. The vehicle is in hover mode and tracks reference position (rather than reference 

velocities) under this transition velocity. The reference position is moved with the pitch and roll sticks, 

while the heading is directed with the yaw stick. （User should try out transition between hover and forward 
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flights under manual velocity control mode in software simulation mode to get familiar with the operation. 

If the hover to forward flight transition velocity is set higher than the maximum velocity, say at least 5 m/s 

more to take into account of GPS error, the vehicle will stay in hover mode under manual velocity control 

mode.）If GPS loses lock, the Kalman Filter falls back to attitude only mode and can no longer track the 

reference velocity, the heading can still be steered with the yaw stick; however, the pitch stick (and the roll 

stick in hover mode) now directly modifies the reference pitch angle (and reference roll angle in hover 

mode), and the throttle level is under manual control until GPS locks again. 

 

For a hover capable vehicle, if the “Constrained Attitude in Manual Mode” option is checked, then the vehicle 

would remain in hover mode under manual control with the attitude stabilized and constrained by the limits 

defined for the respective outer control loop outputs. This feature is helpful when the vehicle is under manual 

control while flying near or inside a building, or even out of sight when flying with an onboard live video feed. 

 

If the manual input device is configured as the integrated receiver or the external receiver, then the BrainyBEE 

avionics controller can work without a BrainyBEE ground station. If an Ublox GPS is connected and in 3D-fix, 

then the Kalman Filter works in full state mode which enables the BrainyBEE avionics controller to operate in 

velocity control mode. Even in the absence of a Ublox GPS module, the BrainyBEE avionics controller can still 

be directed by a pilot in manual mode via the hobby radio transmitter. 

 

A commercially available high quality receiver is modified to connect to the integrated receiver port and has a 

range over 500 meters. A customer can also connect his own external receiver for longer range, simply connect 

each receiver channel to the corresponding external receiver port. Both the integrated and the external receivers 

should be placed away from the wireless data modem and the avionics controller board which runs with a 

powerful DSP that inevitably generates digital switch noise. 

 

For long distance manual control, a pilot can command an aircraft through a Joystick game controller or the 

slider, with the command data uploaded via the wireless modem, which usually has significantly longer range 

than a hobby radio transmitter. Pilot command data is given the highest priority to minimize delay; inactive 

vehicles should be removed from the vehicle network to avoid delays waiting for their response. 

 

The Guidance Tab also defines flight limits including velocity, climb rate, altitude and turn rate. It is very 

important to set the velocity and climb rate limits appropriate for the vehicle. The vehicle must be able to reach 

and keep the maximum or minimum velocity in level flight without losing altitude. The minimum altitude can be 

set for your area to avoid accidentally touching the ground in autonomous flight (The minimum and maximum 

altitudes do not apply for Takeoff and Landing waypoints.) For non fixed-wing vehicle, a hover to forward flight 

transition velocity must be specified: In the manual velocity control mode, if the vehicle’s ground speed is under 

this transition velocity, the flight control works in position tracking mode; over the transition velocity, it works in 

velocity tracking mode; In the autonomous tracking mode, the vehicle works in hover mode only if the active 

waypoint is of Hover type, or if the target velocity for a Takeoff or Landing waypoint is zero (in which case 

autonomous vertical takeoff or landing could take place). The maximum turn rate can be adjusted to achieve 

desired turn performance. 
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Comprehensive safety features are implemented in the event of loss of communications. If the manual control 

signals are lost for more than one second, the vehicle automatically switches from the manual control mode to 

the autopilot mode；If the autopilot mode was in manual velocity control sub-mode, the vehicle will stay in hover 

if it was in hover mode, or flies a left-turning circle if it was in forward flight mode (Note: many high-end 

receivers, particularly PCM type, have safety features that maintain control signals when the transmitter signal is 

lost; such features must be turned off for BrainyBEE avionics controller to properly recognize the loss of 

transmitter control signals). If the “Home Waypoint” is enabled and specified, this home waypoint would become 

active so the vehicle starts to fly home when the BrainyBEE avionics controller loses wireless data 

communication with the ground station. 

 

If “Throw Launch” is enabled, when the “Enable Tracking” button is pressed, the control outputs keep the initial 

trim values as shown on the Control Tab until the minimum velocity (specified in the “Flight 

Limits->Velocity->Min” field in the Guidance Tab) has been reached for more than 0.5 second, after which time 

trajectory tracking is started.  

 

At the bottom of the Guidance Tab is the list of waypoints that define the flight trajectories for this vehicle. 

Flight trajectories are made up with single linked list of waypoints. To avoid fatal errors, new trajectories can 

only be created as draft to be added to the focus vehicle. See details in Section 4.3.4 Draft Trajectories. 

 

The onboard trajectories that belong to the focus vehicle are displayed in red on the moving map, while the 

onboard trajectories for other vehicles are shown in blue. Active trajectories, which include the active waypoint 

that a vehicle is currently tracking, are shown in bright colors. Trajectories can be copied, cut and pasted by 

selecting the target trajectory with a left mouse click then selecting the appropriate action from the menu after 

clicking the right mouse. To increase or decrease the target altitude for the same amount to all waypoints on the 

same trajectory, choose “Alter Trajectory Altitude” from the right click popup menu. Trajectories can also be 

rotated, enlarged or shrunk by pressing the left, right, up or down arrow key while holding down the left mouse 

on the selected trajectories; the edited trajectory is uploaded to the autopilot only when the left mouse is released; 

to abort the action, press the Esc key before releasing the left mouse. 

 

Though trajectories can be easily modified with a few mouse clicks, mission operators are provided with yet 

more options to quickly respond to pressing situations. The “Focus Vehicle Shortcuts” window is normally 

displayed alongside the main moving map window, which allows the operator to suspend trajectory tracking and 

entering preset hover, loitering, climbing, or self-spinning modes for specified duration before resuming 

trajectory tracking. In fact the operator can select any combination of the available lateral, vertical and spinning 

shortcuts for quick and effective response to unforeseen events. The Focus Vehicle Shortcuts window can be 

optionally turned off by selecting “Advanced->Shortcut Commands…Hide” from the main window menu. 

 

Waypoints can be added, deleted or modified in real time to an onboard trajectory. Highlight a waypoint by 

clicking the left mouse over it. Then click the right mouse and select the proper action from the pop up menu. 

Double clicking a waypoint would bring up the waypoint edit window. A waypoint can also be moved by simply 
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dragging it while holding down the left mouse. 

 

Several types of waypoints can be defined. Regardless of its type, when a waypoint becomes active, the vehicle 

takes its target velocity and tracks toward it, climbs or descends following a slope that starts with its current 

altitude and ends with the waypoint’s target altitude. If the manual steering is activated, then the vehicle can be 

steered slightly off track with the yaw control stick, and the reference velocity slightly modified with the pitch 

control stick (In case of Hover waypoint, the yaw control stick changes heading, while pitch and roll sticks 

slightly modify body reference velocities while tracking toward the hover waypoint). For winged forward flight, 

the desired throttle can be set instead of reference velocity. 

 Passover –When reached, the next waypoint becomes active right away. If “pre turn” is checked, the vehicle 

will turn to the next waypoint a bit early to ensure a smooth transition. If “Climbrate” is activated and 

specified, the vehicle will climb or descend at the set climb rate until the target altitude is reached; if the 

climb rate is not set, then the vehicle will follow a slope connecting the target and the previous waypoints. 

 LeftCircle – When reached, the vehicle makes left circle of the specified radius for the specified duration 

before moving on to the next waypoint. If “Tangent Transition” is checked, the vehicle will enter and exit 

the circular orbit tangentially. 

 RightCircle – When reached, the vehicle makes right circle of the specified radius for the specified duration 

before moving on to the next waypoint. If “Tangent Transition” is checked, the vehicle will enter and exit 

the circular orbit tangentially. 

 Hover – Valid for helicopter or VTOL only. The vehicle tracks toward the waypoint with its heading fixed in 

the specified direction (i.e. the vehicle can move sideways while pointing at a fixed direction). The 

maximum velocity is confined by the Hover to Forward Flight Transition Velocity. When the hover 

waypoint is reached, the vehicle hovers for the specified duration while heading in the specified direction 

before moving on to the next waypoint. The reference heading can be re-directed with the yaw control stick 

if manual steering is activated. 

 Takeoff – When the active waypoint is of Takeoff type, the vehicle will attempt to climb at the specified 

climb rate while tracking toward the waypoint. The vehicle moves on to the next waypoint when the 

Takeoff waypoint is reached or the specified Duration has expired, whichever happens first. There is a 

special scenario designed for the vertical takeoff of helicopter and VTOL vehicles: when the target velocity 

is specified as zero, the vehicle will climb straight up for the specified duration from its pre-takeoff position, 

while maintaining its pre-takeoff heading; The reference position can be steered slightly with roll and pitch 

control sticks, while the heading can be re-directed with the yaw control stick. 
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 Landing –When the active waypoint is of Landing type, the vehicle 

will attempt to descend at the specified (negative) climb rate while 

tracking toward the waypoint, and the target velocity is set to zero 

once the landing waypoint is reached. For a model aircraft such as a 

flying wing without a landing gear, it is necessary to switch to manual 

control right before touchdown to avoid damaging the propeller. 

There is a special scenario designed for the vertical landing of 

helicopter and VTOL vehicles: when the target velocity is specified 

as zero, the vehicle will attempt to descend straight down from its 

pre-landing position, while maintaining its pre-landing heading. The 

reference position can be steered slightly with roll and pitch control 

sticks, while the heading can be re-directed with the yaw control stick. 

It is apparent that a Hover waypoint with a low target velocity and a 

duration sufficiently long for the vehicle to stabilize should precede 

the vertical Landing waypoint. 

 

Transient jitter can occur when switching to a new active waypoint and 

tracking the new reference velocity and altitude. It is a good practice not to 

have drastic changes in reference velocity and slope between adjacent 

waypoints. Insert additional transition waypoints if necessary. The design 

of flight trajectories can be improved only with experience, creativeness 

and thoughtfulness. The user is highly recommended to practice in 

software simulation mode with Flightgear or X-plane flight simulator. 

 

In addition to flight properties, a waypoint can also be configured to 

trigger payload servos. (To avoid confusion, the takeoff and landing type waypoints can not trigger payloads). 

Open the waypoint edit window, enable any of the six payload servos and type values between 0-255. Each 

enabled servo will take its target value when that waypoint is reached. For example, a camera can be set to take a 

photo at a waypoint; the landing gear can be programmed to drop for landing. If the duration is set with a 

nonzero value, then the payload output will be reset to the initial value (set on the payload tab) after the specified 

duration in seconds. If the spacing is nonzero, then the payload will be triggered and reset periodically for the 

specified spacing in meters until the next waypoint is reached. During hover or circling, the trigger time interval 

is calculated as the division of the spacing by the reference velocity. The payload servos can also be configured 

and set manually from the Payload Tab. 

 

Before trajectory tracking can start, an active waypoint must be selected. Simply highlight a waypoint with a left 

mouse click, then click the right mouse and from the pop up menu choose “Set Waypoint Active”. The active 

waypoint is shown in green. Now trajectory tracking can be started by pressing the “Enable Tracking” button in 

the Guidance Tab. The current tracking status is shown just above this button. 

 

Figure 4-19 Waypoint Window 
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4.3.6.3  Control Tab 

Most autopilots available on the market today deploy 

the classic PID (Proportional, Integral, Derivative) 

feedback control to track the target set by the 

guidance step, as PID feedback control is easy to 

implement and to tune. However, it is also well 

known that the performance of the linear PID 

feedback control can be modest at best. For example, 

the time scale separation requirement between the 

inner attitude control loop and the outer trajectory 

tracking loop places severe limits on the control 

bandwidth of the outer loop, handicapping the 

trajectory tracking performance of the PID feedback 

control method. 

 

BrainyBEE avionics controller employs an advanced 

technique that can be best described as “model 

reference based nonlinear feedback adaptive control”, 

which drastically improves the trajectory tracking 

performance while remaining robust against external 

disturbances such as gusty wind, and system 

uncertainties such as change of mass or moment of inertia. 

 

This technique deploys model references whose dynamics are defined by the command filter frequencies and 

damping ratios, which generally speaking must correspond well with the responsiveness of the respective control 

loops (Appropriate frequency and damping ratio must be set to define the reference model even if the 

corresponding actuation is missing, such as the case for Airship or rudderless flying wing). When the neural 

network adaptations are activated, the neural network would learn to compensate for the differences between the 

reference model and the actual system dynamics in order to realize high performance self adaptive control; In 

contrast, if the neural network is turned off, then the error integral terms would provide only first order 

corrections with the actual system dynamics. 

 

Approximate linear dynamics under nominal flight condition should be specified with the actuation and the 

angular damping coefficients of the Linear Dynamic Model under the Actuation tab. The actuation coefficient 

represents the control power of the actuation, with unit of (rad/sec2)/rad for actuation by control surfaces, or 

(rad/sec2)/(100%) if differential thrusts are means of innerloop actuation such as the case for X4 flyer. The 

angular damping coefficient describes the inherent angular stability of the vehicle. These coefficients could be 

determined by combination of calculation, measurement and flight tests. If the aircraft oscillates around a 

 

Figure 4-20 Control Tab 
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principal body axis, the corresponding actuation coefficient should be increased; on the other hand, while in the 

autopilot mode, if the aircraft makes circles when hovering or makes S-curves during forward flight, then the 

corresponding actuation coefficient should be reduced. For helicopters, suitable actuation and damping 

coefficients are particularly important for the neural network to properly compensate for the "hidden" dynamics 

due to the interaction between the stabilizer flybar and the main rotor. 

 

The Enorm field displays the aggregate error between the reference model and the actual system states, smaller 

value implies better tracking performance; Fnorm roughly represents the magnitude of neural network adaptation, 

which should remain bounded (Smaller Fnorm indicates that the linear dynamic model closely represents the 

actual dynamics). If Fnorm goes above a preset threshold, the Fnorm field turns red and the neural network is 

suspended until being manually reset, either by pressing the reset button or by rapidly flipping between manual 

and autopilot mode six times. The vehicle dynamics is naturally very different while on the ground, hence it is a 

good practice to reset shortly before takeoff to keep the neural network from possibly going out of bound with 

erroneous adaptations. The neural network adaptation works with blinding speed and should remain robust and 

never go out of bound while the vehicle is in the air. 

 

Neural network based self-learning adaptive control signifies a revolutionary development in flight control. As 

pointed out earlier, rudimentary PID control suffers from inadequate performance, while many other high 

performance techniques require accurate system modeling (often at great expenses) which often cannot cover the 

entire flight envelopes, while lacking robustness with changes in vehicle configurations such as weight and 

moment of inertia. In contrast, the neural network based adaptive control literally learns how to fly on the fly, 

hence delivers consistent high performance as it adapts to moderate changes in system dynamics in a split of 

second. One example of the benefits is that the vehicle can be kept under control with partial system failures 

when other control techniques would not. Overall savings in initial system integration as well as ongoing 

maintenance could be very significant, in addition to performance boost. 

 

The six control groups are displayed under the Control Tab in two rows. The first row defines the parameters for 

the inner control loops which produce the control outputs; the second row shows the parameters for the outer 

control loops that are responsible for position or velocity tracking by setting reference roll and pitch for the inner 

control loops to follow. The minimal throttle level in autonomous mode must be at least 30%. 

 

In manual control mode, each inner control loop can be optionally activated by checking the “Enable in Manual 

Mode” box, to help the tuning of the inner control gains, before setting the outer control gains in the autopilot 

mode. For unstable VTOL platforms such as Aeroranger, the inner control loops are always turned on to provide 

stability augmentation. 

 

Velocity tracking might be difficult or even impossible for fixed wing aircraft under windy conditions. For hover 

capable vehicle such as a helicopter, fully autonomous altitude control might be difficult due to the relatively 

large error in GPS vertical positioning. In both cases a workable alternative is to check the “Manual Throttle in 

Autopilot Mode” box, so that the throttle is under direct manual control. 
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For fixed-wing aircraft, when the “Gain Switch Velocity” is enabled and specified, a second set of control gains 

is enabled for each feedback control loop, which is activated when the vehicle speed surpasses the gain switch 

velocity. For non fixed-wing vehicle types, both sets of control gains must be defined, as the first and second 

columns of control gains correspond to the hover and forward flight modes respectively. 

 

Understanding of control theory is helpful when setting optimal control parameters. So is intuition developed 

over time with experience. In practice, control parameters must be tested out with actual flight tests. The 

BrainyBEE installation package includes sample vehicle configurations for common model aircraft that we 

tested with. 

 

When changes are made to the control parameters, a yellow “Control Config Out Sync” message is shown in the 

status field. Press the “Upload Control Config” button to send the new parameters to the BrainyBEE avionics 

controller. Pressing the “Download Control Config” button would have the current configuration downloaded 

from the BrainyBEE avionics controller. Control Config File Store and Load buttons respectively save to and 

retrieve from the vehicleN.cnt file in the data\VehicleNetwork folder. 

 

The BrainyBEE avionics controller supports fully interactive real-time modifications of any control parameters 

while in flight. However, the pilot must stand ready to take over for manual control if the new control parameters 

prove unstable. 

 

Current control outputs are shown in the “Current Trim” group in the right side of the Control Tab. Keep in mind 

that the BrainyBEE flight control algorithm assumes that the aircraft dynamics are decoupled in the roll, pitch 

and yaw axes. If the servos and control surfaces are not mixed, then the current trims display the actual readings 

for their respective servos or control surfaces, except that the sign convention for pitch actuation is opposite to 

the sign convention for the elevator control surfaces of a fixed-wing aircraft. The reason is that to display control 

outputs for all vehicle types, the sign conventions for roll, pitch and yaw trims are such that they are positive if 

they contribute positively to the torque in their respective axis. The elevator control surfaces should move up in 

order to produce positive torque which is to pitch up the nose. But by convention all horizontal control surfaces 

are positive when they are down. 

 

When the servos or control surfaces are mixed, such as V-tail for fixed wing and CCPM120 for helicopter, then 

the current trims displayed should be viewed as “virtual” control readings had the servos and control surfaces 

had no mixing at all. See more discussions in Section 4.3.6.4  Actuation Tab. 

 

The initial trim group sets the control outputs before autonomous tracking starts. Press “Capture Trim” button to 

capture the current trim values as the initial trim. 
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4.3.6.4  Actuation Tab 

Actuation is where the flight control outputs are translated into the flight servo signals and engine throttle levels 

in ways that are dependant on the vehicle configurations. Hence the content of the Actuation Tab is context 

sensitive. 

 

Various vehicle configurations can be specified including elevon, flaperon and V-tail for the fixed wing aircraft, 

and CCPM120, CCPM90 mix for helicopters. When the vehicle configurations are modified, the labels for the 

eight flight servos change accordingly to show their usage. (Note: various mixings including elevon, flaperon, 

V-tail for fixed wing aircraft, CCPM collective scale and tail mixing for helicopters MUST be set up under the 

Actuation Tab. All mixing MUST be disabled on the transmitter, since the BrainyBEE avionics regards 

transmitter channel inputs as (unmixed) reference angular or translational velocities. As a result, a “3D 

helicopter” with collective control can not perform acrobatic moves such as flying upside down, even under 

manual control. However, such restrictions are expected as a fully autonomous flight control system is supposed 

to remain within nominal flight envelopes.) 

 

For fixed-wing aircraft that requires two elevator or rudder actuation outputs, the payload channel 5 and 6 can be 

configured to mirror the flight servo 2 and 4 respectively, by manually setting payload5MirrorFlightServo2 or 

payload6MirrorFlightServo4 in the payload .pld configuration file, (which must be saved and uploaded to take 

effect). If set to 1, the output is in sync with the mirrored flight control output, which a value of 2 means reversal 

of the original output. 

 

Figure 4-21 Actuation Tab – Fixed Wing 

 

Figure 4-22 Actuation Tab - Helicopter 
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A Linear Dynamic Model should be defined with appropriately chosen angular damping and actuation 

coefficients. See details in the earlier section on Control tab. 

 

Notch filters can be activated to compensate for known structural resonances such as that of a flexible wing, or 

the one associated with helicopter rotor/body interaction. The notch filters are inactive if their depths are left at 

1.0. Higher control gains can be realized with properly set notch filters. 

 

Most servos and actuators do not provide feedback on their current states. The estimated time constant and rate 

limit for each servo should be provided so the inner control loops can partially compensate for best performance. 

It is worthwhile to point out that the neural network adaptation assumes that no “hidden” dynamics exist outside 

the inner and outer control loops. Hence providing a well-informed estimation of the time constant and rate limit 

could mean a boost to the performance of the neural network adaptation. As a general rule, faster servos have 

smaller time constant and higher rate limits. 

 

When the vehicle is not in flight, the Actuation Calibration can be enabled with the “Enable” checker. Choose 

one of three servo pulse widths to activate the corresponding column of eight servo position readings. Measure 

the actual readings for each servo and type in the values. Repeat for all three pulse widths. For optimal 

performance, the estimated servo time constant and rate limit could be set so the autopilot can partially 

compensate for the delay and rate limits of the servos. When done, upload the new configurations by pressing the 

“Upload Actuation Config” button. 

 

When taking measurements of the servo positions, follow these sign conventions:  

 Fixed-wing aircraft: ailerons, flaps, elevators, V-tails are all positive down; rudder is positive right; 

combined ailerons are positive if the left aileron is down. 

 Helicopter: collective and CCPM servos are positive down. Roll servo is positive tilting right; Pitch servo is 

positive pitching up; Yaw servo is positive if the nose turning right. 

 

The polarities of the servos and control surfaces MUST be verified – wrong polarity will certainly result in 

instability and crash. In manual mode, move one control stick at a time on the radio transmitter or the joystick 

game controller and see if the corresponding slider under the moving map moves in the same direction. If not, 

the polarity of the control stick must be reversed ON the radio transmitter or the joystick game controller. After 

verifying the polarities of the control sticks, move the control sticks to see if the servos and control surfaces 

move in the right direction. If any servo moves in the opposite direction, reverse the signs for that servo in the 

Actuation Calibration group. 

 

During the design and implementation of the BrainyBEE flight control system, no effort is spared to find the 

most intuitive and often also the simplest solution given the complexity of the problem at hand. At times 

comprises must be made between functionality and simplicity. When a seemingly “complete” solution adds great 

complexity while contributes little to the overall system performance, it is dropped in favor of a “good enough” 

but simple and effective solution.  
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The actuation calibration is a good example of the compromises we must make. Given the fact that the 

BrainyBEE flight control system is the world’s first integrated solution for practically anything that fly, the 

possibilities are endless if all servo configurations are individually supported. The user interface will be clogged 

and confusing. So we made a decision that only three fixed servo pulses are chosen for calibration, and linear 

interpolation and extrapolation apply for regions outside and in between. 

 

Further complications arise when servo mixing is involved. The “good” bad example is CCPM120 mixing for 

helicopter. Since servo pulses are not individually set during calibration, it is hard to discern individual servo’s 

contribution. 

 

The BrainyBEE flight control algorithm assumes that the aircraft dynamics is decoupled in the roll, pitch and 

yaw axes. The current actuations shown in the bottom section of the Control Tab can be viewed as “virtual 

actuations” had the servo actuations are also decoupled in the three principle axes. The “virtual actuations” are 

combined based on vehicle configurations to produce servo signals. 

 

It is now clear that what really matters is that the servos would combine to produce results qualitatively right, 

and quantitatively as close to the “virtual actuations” as possible. Take the CCPM120 example: when the current 

“virtual” roll actuation shown on the Control Tab is 10 degrees, the three CCPM120 servos should combine to 

tilt the rotor for about 10 degrees to the right. 

 

Aerojeep would provide sample configurations for common vehicle types that users can start with and adapt for 

their own aircraft. 
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4.3.6.5  Payload Tab, Support for Stabilized Camera Gimbals 

The BrainyBEE avionics controller has six 

payload servo outputs. The Payload Tab 

displays the names, the initial values at power 

up, and the current values of the payload 

servos. Each payload servo can be configured 

for manual control with the input device set to 

be the integrated receiver, the external receiver, 

or the joystick game controller. When a 

payload servo is configured for autonomous 

update at a waypoint (except for takeoff and 

landing type waypoints), it will take the target 

value when that waypoint is reached. See more 

details in Section 4.3.6.2  Guidance Tab. 

 

To change the servo name or set servo value 

manually, type new servo names or servo 

values between 0-255 and press Upload button. 

The servo values are periodically updated 

unless being modified when the sync status 

field reads “Out Sync” in yellow. 

 

If “Swap P2 and P6 manual input channel” is checked, the pilot can use the transmitter channel 6 for camera 

pitch control, which is connected to payload output channel 2. The purpose is to allow the pilot to use the same 

transmitter for both flight control and camera pitch control, which makes sense for small aircraft operated by one 

person such as a quadrocopter.  

 

For fixed-wing aircraft that requires two elevator or rudder actuation outputs, the payload channel 5 and 6 can be 

configured to mirror the flight servo 2 and 4 respectively, by selecting control option MirrorS2 or MirrorS4 for 

channel 5 or 6. If MirrorS2R or MirrorS4R is selected, the output is in reverse polarity with the mirrored flight 

control output. 

 

Three ADC payload inputs are available for custom applications. The three ADC ports measure analog voltages 

from 0 to 3 volts in range. Input voltage over 3 volts must be scaled down with resistor bridge circuits as 

overvoltage could result in permanent damage to the autopilot. 

 

The “Focus Vehicle Shortcuts” window also provides a quick interface to payload functions. Set trigger value 

and duration for each payload channel. Then pressing the payload shortcut button will set the payload output to 

 

Figure 4-23 Payload Tab 
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the specified value for the preset duration before returning to its initial value set on the Payload tab. There’s a 

special payload shortcut defined to trigger a parachute to be opened after the throttle is cut for specified period. 

The Focus Vehicle Shortcuts window can be optionally turned off by selecting “Advanced->Shortcut 

Commands…Hide” from the main window menu. 

 

If “Enable log” under Trigger Log is checked, the most recent 1600 payload trigger logs can be stored onboard in 

the autopilot flash memory, and can be downloaded to the ground station by clicking “Download” button under 

Trigger Log, with all the payload trigger logs saved into the .trg file. These logs record in details the time, 

location, velocity and vehicle attitudes each time the payload is triggered. They are very important in facilitating 

post flight data analysis such as image stitching. Click “Clear” button to erase all logs from the flash memory. 

 

Image quality of still picture as well as live video could degrade considerably due to mechanical vibration and 

turbulence. The BrainyBEE autopilot provides feature-rich integrated support for stabilized roll-tilt-pan tri-axis 

camera gimbals (single or double axis gimbals are supported simply by enabling only the active axes). The 

camera gimbals can be installed with its roll, pitch and yaw axes aligned with those of the aircraft, in which case 

the Forward Looking configuration should be selected. Alternatively, if the camera gimbals were to look 

downward most of the time (such as for stabilizing a down looking camera), the “Down Looking” configuration 

should be selected, in which case the roll axis of the camera gimbals should point downward, while its yaw axis 

point toward the aft of the aircraft (defined according to the customary right-hand rule). 

 

In the stabilized rate mode, the camera’s line-of-sight is fixed relative to the Earth reference frame regardless of 

the aircraft body attitude, until re-directed with the manual input device. In the target mode, the camera’s 

line-of-sight is continuously adjusted to point to a user defined landmark. The current line-of-sight target can be 

captured to the custom landmark by clicking on the Target option of Camera Control Mode then providing an 

estimated range to the target. As an example, the target mode can be activated to provide continuous monitor on a 

fixed target from different angles while the aircraft loiters over the target. To take a step further, the BrainyBEE 

ground station can upload landmark updates from third-party video image identification and tracking software to 

the BrainyBEE autopilot to realize the tracking of a moving target in real time. 

 

For hover capable aircraft such as helicopter and x4flyer, the Pan via Hover Heading option can be chosen to 

realize pan-tilt tracking with tilt-only single-axis camera gimbals when the heading of the aircraft acts as pan 

control while in the autopilot mode. The camera gimbals must be carefully calibrated with the actuation limits 

and bandwidths properly set. The current gimbals line-of-sight is illustrated in blue lines superimposed with the 

aircraft attitude in side and top views. 

 

It should be noted that the camera gimbals stabilization function works effectively to offset only the low to mid 

frequency oscillations, hence any high frequency vibrations (e.g. due to engine and/or rotor) must be dealt with 

through high quality mechanical damping and isolation. 
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4.3.6.6  Communication Tab 

The communication tab shows the health of the wireless data link as seen by the BrainyBEE avionics controller. 

It shows only two fields for the current release: 

 Frame Count – a running counter of complete intact data frames received by the BrainyBEE avionics 

controller. It turns red if the count did not increment between screen refreshes. 

 Error Count – number of erroneous frames that failed the checksum test and rejected by the BrainyBEE 

avionics controller. 
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4.4 BrainyBEELiveVideo and Heads-Up Display (HUD) 

BrainyBEELiveVideo software is provided for preview and capture of live video via a video capture device 

based on the Windows Driver Model (WDM) or the older Video for Windows (VfW) standard. After the 

BrainyBEE software is installed, go to the Aerojeep root directory, double click the instFilter.vbs file to install 

video processing filters for the BrainyBEELiveVideo software. 

 

 

Figure 4-24 BrainyBEELiveVideo with Heads-Up Display of Telemetry 

The video capture device must be plugged in before starting BrainyBEELiveVideo. Select “File->Set HUD 

Display…” to activate Heads-Up Display (HUD) feature and select the vehicle ID whose telemetry data shall be 

superimposed onto the live video. The ground station must have network interface turned on for the 

BrainyBEELiveVideo software to connect, which can run on the same host computer or separate computers. 

Unlimited copies of BrainyBEELiveVideo software can run on the same host computer to display live videos 

from multiple video cameras, simply select the respective video capture device from the Devices menu. Select 

“File->Set Capture File…”, then “Capture->Start Capture” to save live video to a file in compressed MPEG2 

format. Move the mouse cursor over the live video and click the right mouse to capture the real-time image 

which is opened and shown by the default graphics display software. 
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4.5 Flight Simulation and Real-time 3D Visualization 

The BrainyBEE ground station can connect to a third-party flight simulator for software in the loop simulation 

and real-time 3D visualization. Two popular flight simulators are supported at this time: FlightGear and X-Plane. 

4.5.1 FlightGear Flight Simulator 

Quoting from its website, FlightGear is an open-source project “to create a sophisticated flight simulator 

framework for use in research or academic environments, for the development and pursuit of other interesting 

flight simulation ideas, and as an end-user application.” FlightGear supports several flight dynamics models 

including aerodynamic coefficients based JSBSim, geometry based YASim, and nonlinear UIUC model. More 

details can be found at FlightGear and other related websites. A user can modify an existing aircraft’s 

configuration files to simulate the behaviors of his own aircraft. 

 

If you have a BrainyBEE CDROM, then a FlightGear installation file is located in the FlightGearSetup\ folder. 

Otherwise, it can be downloaded from www.FlightGear.org. Follow online instructions to install FlightGear on 

your computer.  

 

In addition to executables, FlightGear root directory includes data files such as aircraft configuration and scenery 

files. The base installation includes only the scenery data around the San Francisco Bay area. For users in other 

parts of the world, scenery files for your area must be downloaded from www.FlightGear.org. After that from the 

Start menu, run All Programs->Aerojeep->AtlasMapMaker to convert all scenery files under the FlightGear root 

directory to the AtlasTopo moving map files. 

 

An environment variable “FG_ROOT” must be defined with the value set to FlightGear’s root directory, which is 

“C:\Program Files\FlightGear” unless a different location was chosen during installation. To add an environment 

variable, right click “My Computer” icon, choose “Properties” to open System Properties window. Click the 

Advanced tab, then press “Environment Variables” button to open an edit window. Add a new environment 

variable “FG_ROOT” to the user variables. 

 

Aerojeep made slight modifications to the FlightGear Version 0.9.10’s network interface to get the necessary data 

and to improve efficiency. Two batch files FlightGear_SWI_Simulation.bat and FlightGear_3D_Visualization.bat 

are created under the BrainyBEE root directory to start FlightGear for software simulation and 3D visualization 

respectively. These two batch files internally calls the modified FlightGear executable fgfs.exe under the 

BrainyBEE root directory. But all aircraft configuration and scenery data are taken from FlightGear root 

directory. 

 

To exit FlightGear, from the top menu select File->Quit then confirm. The BrainyBEE ground station 

automatically detects that FlightGear has been disconnected and go into no flight simulator mode. 
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To comply with the GNU General Public License, the modified source code of FlightGear is available upon 

request from Aerojeep. 
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4.5.2 X-Plane Flight Simulator 

Unlike FlightGear which only supports fixed wing aircraft, X-Plane supports anything that can fly. The downside 

is that a user must pay a small fee and its source code is proprietary. Instead of using models with adjustable 

coefficients to describe an aircraft’s dynamic behavior, X-plane directly calculates an aircraft’s movement from 

its geometric shape based on “blade element theory”. X-plane claims to be so aerodynamically accurate that it is 

the first to be FAA certified for flight training. See more details on X-plane’s homepage. X-plane includes a 

rather easy to use plane-maker, so users can design and try out their experimental aircraft before actually 

building it. 

 

If you have a BrainyBEE CDROM, then a trial X-Plane V8.03 installation file is located in the X-PlaneSetup\ 

folder. Otherwise, it can be downloaded from www.x-plane.com. Follow online instructions to install X-Plane on 

your computer. Unless you pay a small fee to obtain a license from X-Plane, you can only run X-Plane for about 

6 minutes before control is locked out. 

 

The two sample vehicles fixed wing v22222 and helicopter 

vehicle v33333 work well with X-Plane Version 8.04’s Radio 

Control fixed wing PT60 and helicopter Raptor 30 respectively.  

 

First, disable joystick inputs for X-Plane since all control 

commands should come from the BrainyBEE ground station. 

Select Settings->Joystick & Equipment, under Axis tab, select 

none for all axes. 

 

X-Plane network interface must be enabled to communicate with 

the BrainyBEE operator interface. From X-Plane’s top menu bar, 

select “Settings->Data Input & Output…” to open a configuration 

window titled “Data Input & Output”. First click the “Data Set” 

tab to show all UDP packets available. Select the following 

packets for output by checking the respective boxes in the first 

column: 

02 – speed, vertical speed 

03 – Mach, G-load 

15 – angular velocities 

16 – pitch, roll, headings 

17 – attack angles, paths 

18 – lat,lon,altitude 

 

Next click the “Inet 2” tab, and check the box next to “IP address of data receiver”, then type the IP address and 

 

Figure 4-25 Configure X-Plane Data Set 
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port of the BrainyBEE ground station. Near the lower left corner, the send rate should be set to 50/sec. 
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4.5.3 Flight Simulation and Avionics Tuning in Software Simulation 

Mode 

When running in the software simulation mode, the BrainyBEE operator interface becomes an integrated training, 

vehicle tuning and flight simulation center. These tasks are accomplished with the help of a third-party flight 

simulator. Currently two very popular flight simulators FlightGear and X-Plane are supported.  

 

The BrainyBEE operator interface and flight simulator are both graphic intensive applications. Thus it’s best to 

run the flight simulator on a separate machine. If they both have to run on the same machine, make sure the host 

computer has a high performance graphic board and lots of RAM. Sometimes the processing delay can cause the 

aircraft to oscillate or even crash in the flight simulator. To alleviate the situation, turn off some features on the 

operator interface such as gridlines, vehicle tracks, trajectories, landmarks etc. Or minimize the moving map all 

together and open the avionics window only. 

 

First, start the flight simulator. In the case of FlightGear, a modified version needs to be run by selecting from 

Start menu “Aerojeep->FlightGear_SWI_Simulation.bat”; for X-Plane, start in normal ways. Select an aircraft 

with “File->Open Aircraft”. Select airport with “Location->Place Aircraft by Airport”. X-Plane can simulate 

various kinds of system failures. Make sure all system failures, particularly engine failure are turned off from the 

“Settings->System Failures…” window. 

 

If the BrainyBEE operator interface is not already running, start it in Software Simulation mode. Open the 

avionics window for the focus vehicle by double-clicking its symbol in the moving map or the highlighted entry 

in the focus vehicle list. Edit the guidance and control parameters if necessary. Make sure the vehicle is stopped 

and not tracking by pressing the “Stop Tracking” button under the Guidance tab if necessary. The “Stop 

Tracking” button will read “Enable Tracking” if the vehicle is currently not in the tracking mode. 

 

On the left panel, there is a Flight Simulator selector. Choose FlightGear or XPlane, a small connection window 

opens. Confirm or change IP address (which is 127.0.0.1 if the flight simulator is run on the same computer), 

then click Connect button. If the connection succeeds, the focus vehicle will be updated with navigation data 

from the flight simulator. (All other vehicles are not affected and their navigation data continue to be updated as 

realistically as possible based on guidance information.) The BrainyBEE flight control loop now produces proper 

throttle and control surface actuations to send to the flight simulator. 

 

Now the flight simulation can start in manual or autopilot mode, exactly the same as in the Flight Control Mode. 

If the aircraft had moved from the end of runway for takeoff, its position can be reset: For FlightGear, from the 

top menu bar, select “Location->Position Aircraft(on ground)”; For X-Plane, from the top menu bar, select 

“Location->Takeoff->Chino”. Read FlightGear or X-Plane manuals for details. 
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For autonomous flight, a flight trajectory must have been defined. Then select an active waypoint, which should 

be of Takeoff type if the aircraft sits still on the runway. Now click the Guidance tab of the focus avionics 

window, press “Enable Tracking” to start fully autonomous flight. You can also get the plane off the ground 

manually with the joystick game controller, and switch to autopilot mode at any time. 

 

Pressing the “v” key while the FlightGear has the mouse cursor focus will switch between several different 

viewing angles. For X-Plane, many view short cuts can be found under the “View” top menu. Both flight 

simulators can also emulate weather conditions. Read their manuals to find out more. 

 

Users can alter the behavior of the aircraft or simply make their own model to simulate their real aircraft. Read 

more details on each flight simulator to find out how. Tuning guidance and control loop parameters in software 

simulation mode saves a lot of time and money. But fine tuning is always necessary with real flight tests. 
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4.5.4 3D Visualization in Flight Control, Playback and Remote 

Terminal Mode 

Both FlightGear and X-Plane have rather detailed worldwide scenery that is compiled based on real world data. 

When run in the Flight Control, Playback or Remote Terminal Mode, the BrainyBEE operator interface can send 

the navigation data of the focus vehicle to either FlightGear or X-Plane for 3D visualization, and to improve 

situational awareness such as when comparing with a live video downlink. 

 

First, start the flight simulator. In the case of FlightGear, a modified version needs to be run by selecting from 

Start menu “Aerojeep->FlightGear_3D_Visualization.bat”; for X-Plane, start in normal ways. X-Plane can 

simulate various kinds of system failures. Make sure all system failures, particularly engine failure are turned off 

from the “Settings->System Failures…” window. 

 

On the left panel of the BrainyBEE operator interface, there is a Flight Simulator selector. Choose FlightGear or 

XPlane, a small connection window opens. Confirm or change IP address (which is 127.0.0.1 if the flight 

simulator is run on the same computer), then click Connect button. If the connection succeeds, the BrainyBEE 

operator interface will start to send the navigation data of the focus vehicle to the flight simulator for 3D 

visualization. The display could look a bit animated or slightly jerky, because the navigation update rate is only a 

few times a second. 

 

Pressing the “v” key while the FlightGear has the mouse cursor focus will switch between several different 

viewing angles. For X-Plane, many view short cuts can be found under the “View” top menu. Read their manuals 

to find out more. 
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4.6 Portability, Scalability and Network Interface 

From get-go the BrainyBEE flight control system is designed for portability, scalability and “networkability”. 

Platform independent development tools and libraries are utilized whenever possible. Hence the ground station 

operator interface can be ported to other systems such as Linux, or handheld devices when demands arise. 

State-of-the-art object oriented modular architecture is meticulously designed to strike an optimal balance of 

functionality and scalability, allowing seamless functional enhancement and customization. The BrainyBEE 

avionics controller is readily customizable to accommodate additional sensor inputs such as an altimeter, a 

custom GPS, or a laser gyro to further enhance guidance and control. The user friendly BrainyBEE operator 

interface is an integrated training, simulation, as well as command and control center of a UAV network of 

various platforms including fixed wing aircraft, helicopter and VTOL, with the number of vehicles limited only 

by the communications bandwidth. 

 

The BrainyBEE flight control system is also network enabled in the sense that it is ready to interact with a third 

party software, allowing the full functional and data access by the alien master. As a matter of fact, a remote 

terminal is just such an example. The remote terminal connects to the host ground station from anywhere in the 

world via the Internet, retrieves the current configurations, then continues to receive configuration and periodic 

telemetry updates form the ground station. The remote terminal has all the authority and functionality as the host 

ground station, allowing comprehensive monitor and control by a command center far removed from the 

frontline. 

 

The network interface is designed to support sophisticated tactics and strategies. One example is to allow a third 

party “translator” between BrainyBEE flight control system’s proprietary protocol and the language in use by a 

customer’s own command and control system. The other example is to support the networked UAV “swarming” 

strategy, where dozens or even hundreds and thousands of UAVs are coordinated to achieve a common mission 

goal such as providing maximum coverage of targets while avoiding threats and meeting other system constraints. 

The BrainyBEE operator interface provides a user friendly front end to define targets, threats, as well as other 

system constraints such as minimum and maximum velocity, turn radius etc. A third party optimal trajectory 

software can connect to the BrainyBEE ground station via network interface and request any configuration and 

telemetry data that it needs, and calculate the optimal trajectories for all vehicles in the network such that 

together they maximize target coverage while minimizing threats. The optimal trajectories are then uploaded to 

each vehicle via the BrainyBEE ground station. Aerojeep has identified an advanced real-time nonlinear 

constrained optimization technology, and is ready to work with competent partners on developing such 

intelligent autonomous system when the right opportunity arises. 

 

 


